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About This Book Appeon® PowerServer® 2017

1 About This Book

1.1 Audience

This book iswritten for devel opers who want to develop new Web applications or
deploy their existing SAP® PowerBuilder® applications to the Web with Appeon® for
PowerBuilder®.

1.2 How to use this book

There are seven chaptersin this book.

Chapter 1: About This Book

A general description of this book.

Chapter 2: Web RAD with PowerBuilder and Appeon

Introduces rapid Web application devel opment using PowerBuilder and Appeon
PowerServer.

Chapter 3: Migration Process

Describes the methodology of Web conversion based on an existing PowerBuilder
application.

Chapter 4: Migration FAQ

Frequently asked questions and answers regarding the deployment of PowerBuilder
applications to the Web with Appeon PowerServer.

Chapter 5: Building and Migrating Distributed Applications
Specific instructions for the Web migration of distributed applications.
Chapter 6: Enhancing an application with Web or Appeon features

Describes the key enhancement features that you can add in the PowerBuilder application to
make them effective in the deployed application.

Chapter 7: Migration Tutorial

Walks you through the entire process of deploying a small PowerBuilder application to the
Web.

1.3 Related documents

Appeon provides the following user documents to assist you in understanding Appeon
PowerServer and its capabilities:

* Introduction to Appeon:

Gives general introduction to Appeon PowerServer and its editions.

» Getting Started (for PowerServer Mobile):

Guides you though installing PowerBuilder and Appeon PowerServer, and developing and
deploying a mobile application.
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New Features Guide:

Introduces new features and changes in Appeon PowerServer.

» PowerServer Mobile Tutorials:
Gives instructions on deploying, running, and debugging the mobile application,
distributing native mobile apps, and configuring the PowerServer cluster.

» PowerServer Mobile (Offline) Tutorials:
Givesinstructions on setting up the PowerServer Mobile (Offline) environment, and
configuring, deploying, running, updating, and debugging the offline application.

» Appeon Installation Guide:

Provides instructions on how to install Appeon PowerServer successfully.

» Mobile Ul Design & Development Guide:

Introduces general guidelines on designing and devel oping the mobile app and UI.

» Migration Guidelines for PowerServer Web:

A process-oriented guide that illustrates the compl ete diagram of the Appeon Web
migration procedure and various topics related to steps in the procedure, and includes
atutorial that walks you through the entire process of deploying a small PowerBuilder
application to the Web.

» Supported PB Features:
Provides adetailed list of supported PowerBuilder features which can be converted to the
Web/Mobile with Appeon as well as which features are unsupported.

» PowerServer Toolkit User Guide:

Provides instructions on how to use the PowerServer Toolkit in Appeon PowerServer.

» Workarounds & API Guide:
Provides resolutions for unsupported features and various APIs to facilitate you to
implement the features (including Web and mobile) that are not easy or impossible to
implement in the PowerBuilder IDE.

» Appeon Workspace User Guide:
Gives agenera introduction on Appeon Workspace and provides detailed instructions on
how to useit.

» PowerServer Configuration Guide:

Providesinstructions on how to configure PowerServer Monitor, establish connections
between PowerServer and database servers, and configure AEM for maintaining
PowerServer and the deployed applications.

* Web Server Configuration Guide:
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Describes configuration instructions for different types of Web serversto work with the
PowerServer.

 Troubleshooting Guide:

Provides information on troubleshooting issues; covering topics, such as product
installation, application deployment, AEM, and Appeon application runtime i ssues.

» Appeon Performance Tuning Guide:

Provides instructions on how to modify a PowerBuilder application to achieve better
performance from its corresponding Web/mobile application.

» Testing Appeon Web Applications with UFT:
Providesinstructions on how to test Appeon Web applications with UFT.

1.4 If you need help

If you have any questions about this product or need assistance during the installation
process, access the Technical Support Web site at http://www.appeon.com/support.
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2 Web RAD with PowerBuilder and Appeon

Developers can utilize PowerBuilder and Appeon PowerServer to achieve rapid Web
application development (Web RAD). Web RAD with PowerBuilder and Appeon greatly
reduces the software development life cycle and I.T. development complexity, while
preserving end-user productivity.

2.1 Traditional approach to Web development

In order to write even asmall Web application with traditional methods, it takes a great deal
of time, and the resulting Web application usually has an oversimplified user interface. Web
application developers must master various new skills, such as ASP/JSP/PHP, Ruby, Python,
Perl, JavaScript, Ajax, XML, HTML, Java, .NET, and J2EE when using Microsoft or Java
technologies.

2.2 Advantages of Appeon for Web RAD

Using PowerBuilder and Appeon to develop powerful Web applications has the following
advantages:

2.2.1 Provides the fastest path to the Web

Appeon PowerServer achieves unparalleled reductions in project cycle time and costs by
eliminating the traditional Web application design, coding, and testing effort associated
with rewriting applications for the Web. When your objectiveisto build a new application,
Appeon provides the most productive development approach for building enterprise-class
applications that adhere to the most stringent Web standards.

2.2.2 Provides the best Web GUI possible

Appeon Web applications precisely replicate the desktop application user interface with
HTML running in standard Windows Web browsers. Appeon graphical capabilities make the
end user far more productive than any possible rewrite and eliminates all user-retraining time
and costs.

2.2.3 Minimizes business risks

Appeon PowerServer greatly reduces business risks associated with building new software
applications, because the time-tested PowerBuilder program code and DataWindows run at
the core of the Web application.

2.2.4 Leverages current organizational skills

Appeon PowerServer:

* Relies solely on PowerBuilder skills and IDE to develop and maintain the application.
* Reuses the existing application source code and database, preserves investmentsin

designing, building and testing the application Ul, application business logic, data-access
logic, and the database.
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» Operates upon asingle set of native PowerBuilder source code for deployment to both
desktop and Web environments.

2.3 Leveraged functionality with server components

Appeon's support to .NET/COM components enables you to access enhanced Web
functionality. When developing new Web applications with PowerBuilder and Appeon,
you can use the .NET/COM components in PowerServer as a bridge to access many other
functions on the Web and some Client Server application features that may even transcend
the Web limitations. For detailed description, refer to Section 2.3.7, “Calling .NET/COM
server components (.NET only)” in Workarounds & API Guide.

2.4 Appeon Web RAD methodology

Web RAD (Rapid Application Development) with PowerBuilder and Appeon is for writing a
new PowerBuilder application and converting it to the Web using Appeon PowerServer.

There are three stepsin an Appeon Web development project:

Step 1: Analyze the project requirements. According to these requirements, lay out the
function specifications that should be met for the project.

Step 2: Develop a new PowerBuilder application and implement the functionsin it with
PowerBuilder programming that conforms to the Appeon PowerBuilder coding standards.

During the coding process, utilize the Code Insight tool in PowerServer Toolkit to make sure
the new code does not contain unsupported features.

While you develop a new PowerBuilder application, keep in mind one of the more
recent and stringent standards, the Section 508 Amendment to the Rehabilitation
Act. Refer to the whitepaper available at http://www.sybase.com/content/1035234/
PB_508 Compliance wp.pdf for details of the standard.

Step 3: Migrate the PowerBuilder application to the Web with Appeon PowerServer by
following the migration process described in Chapter 3, Migration Process.

Most of the time and effort in Appeon Web RAD methodology is spent working in the
PowerBuilder IDE to code the desktop PowerBuilder application.

2.4.1 Appeon-standard PowerBuilder coding

Appeon PowerBuilder coding standards are recommended ways to write PowerBuilder
code so that it can be recognized and translated into corresponding Web languages (HTML,
JavaScript and XML) by Appeon.

The Appeon PowerBuilder coding standards are laid out in Supported PB Features for
PowerServer Web. When coding the new PowerBuilder application, you should refer to this
document to ensure the Appeon PowerBuilder coding standards are followed.

After writing the new PowerBuilder application, use the PowerServer Toolkit integrated into
the PowerBuilder IDE to automatically convert the PowerBuilder application to the Web.
Some further modifications to the PowerBuilder application may be needed in order to make
the application fully functional. Finally, convert the PowerBuilder application and deploy the
Web application to servers for production use. For detailed instructions on Web deployment,
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refer to Chapter 6, Deploying PowerBuilder Applicationsin Power Server Toolkit User
Guide.

Migration Guidelines for PowerServer Web Page 6



Migration Process Appeon® PowerServer® 2017

3 Migration Process

3.1 Introduction

Instead of providing detailed instructions on each step, this chapter emphasizes the overall
process. Each section may reference other places within this document or other Appeon
documents and support information.

If your goal isto write acompletely new PowerBuilder application and deploy it to the
Web, first refer to Chapter 2, Web RAD with Power Builder and Appeon, and then refer to
instructions in this chapter for migrating the new PowerBuilder application to the Web.

The following figure illustrates the general process of deploying an existing PowerBuilder
application to the Web. The processis divided into two phases:

» Phase One: Planning - Evaluating strategies for your Web migration objective.
Step 1: Install required software

Step 2: Understand the general limitations of the Appeon solution

Step 3: Define migration objective

» Phase Two: Implementation - Implementing your Web migration objective.

Step 4: Upgrade the original PowerBuilder application

Step 5: Prepare the target PowerBuilder application

Step 6: Pre-configure for Web application

Step 7: Remove or workaround unsupported features

Step 8: Enhance the application with Web or Appeon features

Step 9: Tria deployments
Step 10: Debug Web application
Step 11: Performance fine-tune

Step 12: Go-live deployment
Step 13: Go live

Migration Guidelines for PowerServer Web Page 7
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Figure 3.1: Appeon Web Migration Process
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3.2 Installing required softwares

The first step in the Web migration processisto set up the software environment.

Figure 3.2: Appeon Power Server worksin a standard n-Tier Web ar chitecture

Client PCi=)

Serwer

The following softwares should be installed to support the architecture:
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* Windows Server 2016, 2012 R2, or 2008 R2, Windows 7, or Windows 8/8.1

» Microsoft Internet Explorer 8.0 or above, Microsoft Edge, Google Chrome, Mozilla
FireFox, or Opera

* PowerBuilder
» Database that your application uses
» Application Server (any of the following types):

* Microsoft NET Framework & Microsoft 1S

Oracle WebL ogic

IBM WebSphere

TmaxSoft JEUS

JBoss
» Appeon PowerServer, which includes:

» PowerServer (Which includes AEM, PowerServer Status Monitor, and PowerServer
Web Component)

» PowerServer Toolkit (Windows only)
» PowerServer Web Component
» PowerServer Help (Windows only)

For detailed instructions on installing the required softwares, refer to Installation Guide
for .NET.

3.3 Understanding the general limitations of the Appeon solution

There are some general limitations in the migration capabilities of Appeon PowerServer.
These limitations affect how well a PowerBuilder application is suited for Web migration
with Appeon. It isvery important to be aware of these limitations in advance.

Table 3.1: Limitations of the Appeon solution

Limitation What it limits... Try towork around the limit by...
Coding style Appeon recommends not using | Avoiding the coding styles that do
certain coding styles such as not work well with Appeon based on
generic code. advicesin Supported PB Features for
PowerServer Web.
Database Appeon PowerServer supports | Always using the supported database

the following database types: types.

SAP ASE, SAP SQL Anywhere,
SAP HANA, Microsoft SQL

Migration Guidelines for PowerServer Web Page 9
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Limitation What it limits... Try towork around thelimit by...

Server, Oracle, IBM DB2, SAP
1Q, MySQL, Informix, Teradata,
or PostgreSQL

For details, see Installation
Guidefor .NET.

Unsupported The Supported PB Featuresfor | Working around unsupported
features PowerServer Web provides alist | features by following the Chapter 6,
of supported and unsupported Workarounds for Unsupported
features. Featuresin Workarounds & API
Guide.

For more information regarding the limitations, we recommend you read Chapter 2, Basic
Requirements and Recommendations in Supported PB Features for Power Server Web.

3.4 Defining migration objective

There are three typical migration objectives:
» Convert an existing PowerBuilder application to the Web.

 Extract a portion from an existing PowerBuilder application, such as a set of Windows and
key functions, and migrate that portion to the Web.

» Migrate some Datawindows from the original PowerBuilder application to the Web.

3.4.1 Defining migration objective for non-PFC application

Step 1: Calculate the total size of the PBL s that make up the original PowerBuilder
application.

Step 2: Identify the major unsupported features in the existing PowerBuilder application.

Step 3: Briefly assess the amount of work needed to modify the unsupported featuresin the
existing PowerBuilder application. The assessment standards are as follows:

» The more complex the PowerBuilder application is, the more difficult it isto modify its
unsupported features. The complexity can be characterized by advanced coding techniques
including deep inheritance, etc.

If there isalarge amount of business|ogic on the Client-side (e.g. in Windows and

behind controls) and the logic is complex (e.g. it fires 20 events before the businessrule is
completed), then your application will most likely benefit from moving the business logic
into n-Tier NV Os. This takes additional work and needs to be factored in.

» The more unsupported features the PowerBuilder application has, the more effort it takes
to modify them.

Section 3.8, “Modifying unsupported features’ provides methods on working around
unsupported features.
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Step 4: Decide the migration objective:

 If itisimperative that your company move business to the Web quickly, select the first
migration objective and deploy the entire PowerBuilder application to the Web; otherwise
select the second or third migration objective.

» Based on the assessments in the previous step, if substantial effort is required to modify the
unsupported features in the original PowerBuilder application, you may want to consider
converting part of the application to the Web (objective 2). Regardless of the approach
taken, it will alwaystake less work to deploy a PowerBuilder application to the Web
with Appeon than to rewrite it with 2EE/.NET, as PowerBuilder is highly productive,
especially for your PowerBuilder team.

» Thethird possible objective isto deploy only your application Datawindows to the
Web (separately from the application). Thisinvolves building a much smaller new
PowerBuilder application and reusing the existing DataWindows. Thisisalogical solution
when some key reporting functionality or data needs to be available on the Web in avery
short time and it would otherwise take significant effort to deploy the entire application.

3.4.2 Defining migration objective for PFC application

3.4.2.1 Corporate PFC architecture
The following diagram illustrates the typical architecture for PFC applications.

Figure 3.3: Typical PFC applications ar chitecture

app 1 app 2 appn

AT ﬁﬁ

Corporate Class Library

i

PFC Ancestor Level PBLs

The Corporate Class Library extends the PFC Ancestor Level, and contains customized

and enhanced functionality for reuse by various applications within the entire corporate
classlibrary. The PFC Extension Level PBLs are included in the Corporate Class Library,
and utilized to extend the PFC Ancestor Level. For example, corporate analysts may add
intermediate extension level (s) between the PFC Ancestor Level and the Extension Level, or
they can use the existing PFC Extension Level.

Depending on the business need and corporate complexity, sometimes the PFC Ancestor
Level isextended further into several layers containing corporate departmental standards and
businessrules. These several layers are all included in the Corporate Class Library.
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3.4.2.2 Defining migration objective progressively

If your PFC application's architecture has a large corporate layer, Appeon recommends

that you first aim to migrate a small application to the Web or portion of your existing PFC
application to get your framework working on the Web, then expand to deploy alarger
portion of your application or the entire application. This progressive approach prevents
you from being confronted by many problems at the same time; otherwise, you may be
overwhelmed with unsupported features that exist in both the application and the Corporate
Class Library.

Step 1: Deploy asmall PFC application that consists of the following three parts:

» A small amount of application-specific logic separated from the Individual Application.
» Corporate Class Library

* PFC Ancestor Level

In this step, the application-specific logic should be kept small and simple so you can focus
on migrating the PFC Ancestor Level and the Corporate Class Library onto the Web. The
PFC Ancestor Level and Corporate Class Library are more important because they are the
base classes for all corporate applications.

Step 2: Gradually increase the size and complexity of Individual Applications, and change
your focus to fixing the Individual Applications for Web deployment.

3.5 Upgrading the original application

Appeon PowerServer 2017 supports PowerBuilder 9, 10, 10.5, 11, 11.5, 12, 12.5, and 12.6.
Any PowerBuilder source code that is intended for deployment to the Web MUST first be
upgraded to be 100% compatible with the required PowerBuilder version. If your application
is not upgraded, you will encounter runtime errors with the deployed Web application.

3.5.1 Upgrading obsolete PBLs

When loading PBL s from a previous version (e.g. PowerBuilder 5) into alater version,
many error messages may appear in the PowerBuilder Output window. Since inheritance
propagates are an issue from the ancestor object to all its descendant objects, some of the
errors reported may actually come from a single source.

One common type of error found when upgrading PowerBuilder applicationsis string
corruption. To correct these errors, edit the source code (by selecting Edit Source from the
context menu on the error item displayed in the Output window). Errors will disappear when
performing a Full Build to the application target.

3.5.2 Upgrading PFC applications

PFC applications intended for Appeon Web migration must be upgraded to be compliant
with PFC 9 or later. Some legacy PFC applications are based on the PFC 5.0 PBL s that have
been migrated to the newer version, and you should upgrade those applications to use the new
PFC 9 or later PBLs.
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The PFC PFCOLD.PBL library contains obsolete objects that are not supported for Appeon
Web migration. If the original PowerBuilder application is a PFC application that uses
objectsin the PFCOLD.PBL library, you should remove the objects when upgrading the
application to PFC 9 or later.

3.6 Preparing the target application

In this step, you need to process the original PowerBuilder application to create the target
application. Thiswork focuses on transforming the original PowerBuilder application into
atarget application that complies with Appeon architectural guidelines set in Supported PB
Features for PowerServer Web.

3.6.1 Special processing required for PFC applications

Appeon supports most PFC features. As such, under most situations the existing PFC code
can also work under the Appeon environment without any modifications. However, there
are afew features that are not supported. For that handful of unsupported features, Appeon
would devise aworkaround or alternate implementation of those features. Then, the PFC
framework would be enhanced with any auto-sensing feature that would detect whether the
PFC framework is being run as Client/Server or as PowerServer Web. If Client/Server, then
for those features that Appeon does not support it will execute the original Client/Server
implementation. If Web, then only for those features that Appeon does not support it will
execute the modified implementation. Refer to Processing PFC Applications for detailed
instructions on how to modify the unsupported PFC features.

After modifying these unsupported features, you can deploy the PFC application just as how
you deploy a normal PowerBuilder application.

3.6.2 Processing application based on migration objectives

The following table shows what processing tasks you need to perform based on your
migration objective.

Table 3.2: Process application based on migration objectives

If you plan to migrate... Do thefollowing...

Entire original application | 1. Test the original PowerBuilder application and correct any
applications functionality or user interface problems.

Note: This step isfor detecting and removing problems
that may have existed in legacy PowerBuilder applications
or problems caused by upgrading legacy PowerBuilder
applications.

2. Perform afull build and optimize the origina PowerBuilder
application in PowerBuilder IDE.

A portion of theoriginal | 1. Extract the desired portion from the original PowerBuilder
application application into a new PowerBuilder application target.

2. Test the application to ensure there are no bugs and that it
functions as expected.
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If you plan to migrate... Do thefollowing...

3. Perform afull build and optimize this "extracted" portion of
your application in the PowerBuilder IDE.

Some DataWindowsinthe| 1. Create a new PowerBuilder application target in the same
original application workspace that holds the original PowerBuilder application.

2. Move the desired DataWindow objects from the original
PowerBuilder application to the new PowerBuilder
application target.

3. Add Windows, Menus, and a general Ul for the application.
Code simple business logic to the new PowerBuilder
application in order to make it fully functional.

4. Test the new PowerBuilder application and correct any
problems with its functionality and user interface.

5. Perform afull build and optimize the new PowerBuilder
application in the PowerBuilder IDE.

3.7 Pre-configuring for the Web applications

3.7.1 Why is pre-configuration necessary

The following illustration of the Appeon migration solution helps explain why these pre-
configurations are necessary.

Figure 3.4: Before and after Appeon Web migration

Before Target PB app Targe PB app
migration FAT client (05}
IL DB server

After Wb app " Ex Wb app (2 | (1]
migration HTRL LI - husiness logic Wb spp DB

Web saver middleware DB server
app saver

b

Before the Web migration, the heavy client of the target PowerBuilder application interacts
with the Database Server. If the application is distributed, the client also interacts with the
application server that hosts and executes important business logic for the target application.

After the Web migration, the Web application has an n-Tier Web architecture involving
PowerServer as the middleware to hold business logic. This structure is called Browser
Server, because the Web application is accessed via Web browsers such as Internet Explorer.

Making the prospective Web application function in an n-Tier Web environment requires
more than just hosting the HTML user interface and the business logic on the servers.
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3.7.2 Four pre-configuration tasks

Asindicated by the numbersin Section 3.7.1, “Why is pre-configuration necessary”, four
pre-configuration steps are necessary:

Task #1: Manually set up the Web application database server (non-Appeon task). This task
is no different from setting up the PowerBuilder application database server.

Task #2: Manually set up communication between the back-end DB server and the
middleware PowerServer. Specificaly, set up JDBC data sources (non-Appeon task).

Refer to Chapter 4, Database Connection Setup in Power Server Configuration Guide
for .NET or in PowerServer Configuration Guide for J2EE for instructions on this task.

Task #3: Set up communication between the Web application Ul (hosted on the Web server)
and the Web application business logic (hosted on PowerServer). Thisis done viathe

Web server configuration for the application (Appeon task). Thistask is not required if
PowerServer and Web server are set up on the same machine, because the communication
will be automatically set.

Refer to Web Server Configuration Guide for instructions on this task.

Task #4: Configure PowerServer Toolkit so that it has sufficient information to automate the
task of converting and deploying the target PowerBuilder application (Appeon task).

Refer to PowerServer Toolkit User Guide for instructions on this task.

3.8 Modifying unsupported features

Some PowerBuilder features cannot be supported because:

1. Thereare architectural differences between desktop applications and Web applications.
The functionality in a Web application is often limited with regards to desktop
applications.

2. The current version of Appeon PowerServer does not support every PowerBuilder
programming feature.

Unsupported features, if not modified, will be commented out in the generated Web files.
The code that contains the unsupported features and other code that is dependent on those
unsupported features will stop working.

This step involves modifying the unsupported features that have some functional impact on
the running of the application. Some cosmetic features, such as "Border" property, can be
ignored during the modification processif they will not affect the application.

3.8.1 How to identify unsupported features

Three primary sources of information can guide you in identifying Appeon-unsupported
features in the PowerBuilder applications:

» Unsupported Features Analysis (UFA) report - Thistool isincluded in the PowerServer
Toolkit. It scans the PowerBuilder application for its unsupported features and assists you
in making changes to unsupported features. For instructions on how to use the UFA, refer
to Chapter 5, Using UFA Tool in Power Server Toolkit User Guide.
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* Codelnsight - Thistool is also included in the PowerServer Toolkit toolbar. It helps you
directly identify unsupported code in the PowerBuilder painter. For instructions on how to
use the Code Insight, refer to Chapter 12, Developing with Code Insight in Power Server
Toolkit User Guide.

» Supported PB Features for PowerServer Web - ThisHelp fileis a searchable HTML file
that can be launched by clicking the PowerServer Help button in the PowerServer Toolkit.
It lists the supported and unsupported features in details and provides recommendations for
writing convertible PowerBuilder code following the Appeon coding standards.

3.8.2 Feature modification methods

Y ou can modify unsupported code by following the instructions in Chapter 6, Workarounds
for Unsupported Featuresin Workarounds & APl Guide. The Guide provides examples of
some common unsupported features and ways to work around them.

The following modification method is included in Workarounds & APl Guide, and worth
highlighted here because of its importance:
* (Windows only) Using the Appeon workaround for distributed DataWindows.

Appeon Workaround PBL provides two objects appeondatawindow and appeondatastore,
and four functions GetFull State, SetFull State, GetChanges and SetChanges, for supporting
distributed DatawWindows.

3.9 Enhancing the application with Web or Appeon features

Thisisan optional step. Some enhancement features can be automatically included in the
deployed application, but some features require you to make changes in the PowerBuilder
application first. The following lists the key enhancement features that you should add in the
PowerBuilder application to make them effective in the deployed application:

» PowerServer open interfaces that can be called to manage all the applications run at
PowerServer

» Appeon client functions that can be called to get client information or enable Appeon
DatawWindow menu

* Integration with other applications via CommandLine argument, or HyperLink controls

Chapter 5, Enhancing an application with Web or Appeon features provides you instructions
on how to implement a number of Web or Appeon features in the deployed application.

3.10 Trial deployments and debugging

Having completed the previous steps, the target PowerBuilder application is ready for the
first trial deployment.

Tria deployments are the intermediate deployments before the final go-live deployment. For
detailed instructions on deployment and running of Appeon Web applications, refer to the
PowerServer Toolkit User Guide.
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3.10.1 Special deployment steps for distributed applications

Special deployment steps are required for distributed applications with or without distributed
DatawWindows.

3.10.2 Debugging deployed applications

There may be issuesin the trial deployment. For example, afeature in the Web application
may work differently from the target PowerBuilder application or not work at al. These
issues are usually caused by unsupported features or known issues (documented in the
Appeon Release Bulletin). Since UFA cannot detect every single different feature between
Client/Server application and Browse/Server application, it is possible that your application
contains an unsupported feature.

It is essential to debug the Web application and find the cause of the problem. Y ou can use
Appeon Debugger to debug an Appeon Web application. For detailed instructions, refer to
Chapter 7, Debugging Appeon Web Applications in Power Server Toolkit User Guide.

After modifying the target PowerBuilder application according to the debugging result,
perform another trial deployment to seeif the Web errors still exist in the Web application.
The"Tria deployment -> Debug Web application™ process may need to be repeated many
times before the Web application functions properly.

3.11 Fine-tuning the runtime performance

Given the architectural differences between Client/Server applications and Web applications,
each of these has advantages and disadvantages. Typically, Web applications offer better
server scalability, while Client/Server applications provide a superior user experience (i.e.
rich GUI) and better runtime performance.

Appeon Web applications offer the rich PowerBuilder GUI with the scalability of n-Tier
Web architecture. The rich PowerBuilder GUI ensures that the superior user experience and
high user productivity is preserved. The server scalability is comparable to J2EE applications
or .NET applications, if not better, since Appeon moves more processing from the server

to the Client. The PowerServer Performance Tuning Guide has laid out the PowerBuilder
programming features and coding styles that lead to poor Web performance, and it provides
suggestions/'workarounds. Refer to the PowerServer Performance Tuning Guide for more
information.

3.12 Go-live deployment

Go-live deployment deploys the target PowerBuilder application to your production servers.
Check the following settings in the PowerServer Toolkit Application Profile befor e starting
the final deployment to your production servers:

» Set the Web file generation mode to Release - This encrypts the JavaScript code in the
Web application, thereby protecting your organizations business rules and intell ectual

property.

» Turn off al Report options - Thiswill reduce the size of Web files and boost the runtime
performance of the deployed Web application.
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» Check that the required database types are properly configured and sel ected.

» Check that the required additional files (such asINI files, NET/COM components, image
files, DLL/OCX files) are properly configured or selected.

Refer to the PowerServer Toolkit User Guide for detailed instructions on how to perform
application deployment.

Check the following settingsin AEM after performing the final deployment to your
production servers:

» Configure and ensure that transaction objects and data sourcesin AEM can be successfully
connected.

» Check that Run Mode for the go-live application is set to Normal Mode.

» Check Configuration Summary for the go-live application to ensure they apply to the go-
live environment, such as DLL/OCX configurations, 32-bit/64-bit |lE compatibility etc.

» Changethe AEM default username and password as appropriate to ensure the security of
AEM

Refer to PowerServer Configuration Guide for .NET or PowerServer Configuration Guide for
J2EE for detailed instructions on how to configure AEM.

3.13 Go live

Go-liveisthe last step in the Web migration process for the application to go live
successfully without serious problems, Appeon strongly recommends you have done the
following tasksin all related areas to reduce the likelihood of go-live problems:

Unsupported Features:

» Ensure there are no unsupported features in the application. At a minimum, the UFA report
should not list any unsupported features.

Performance fine-tune:
» Read and follow the best practices defined in the PowerServer Performance Tuning Guide.
Functionality:

» Verify al application functionality is working properly. Functionality should be tested on
all the browser version(s) that will be supported. For example, |E 7 32-bit, |E 8 32-hit, IE
8 64-hit etc. Please note: if the application uses third-party DLLS/OCXS/OLES then 64-bit
version of those files need to be packaged in order for the Web application to run correctly
on 64-bit browsers.

Hardware/Software configuration:

» Select appropriate hardware to install PowerServer. Appeon can give some suggestions
based on the # of users, but in general use the most powerful server that customer has
budget for.
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Configure 11S settings properly. Appeon can give some suggestions based on the # of users
and type of hardware that will be used.

Understand the Web browser and system configuration/settings requirements and ensure
that all users are aware of these requirements and that their browser settings are correct. If
third-party DLLSOCXS/OLEs are used the Web browser and system settings will need to
be significantly changed, so if possible for ease of deployment and user satisfaction it is
most preferred to avoid any third-party DLLSOCXS/OLEs.

Performance and scalability:

Verify the application response time over "realistic" network connection. What we mean
by realistic isto use the same network connection (bandwidth and latency) that the average
user will use. Test all application functionality to ensure that the application performs well.

Verify the application scalability. There are two ways to do this. Oneisto use a scalability
testing tool such as LoadRunner. The other option (and more preferred) would be to do
apartia betatest. Essentially, get agroup of userstogether to simultaneously use the
system to seeif any problems. The problems you are looking for is significant degradation
in performance when multiple users on the system and/or system instability (e.g. I1S or
database stops responding or crashes).

Beta test and controlled roll-out:

Perform a beta test. Roll out the application to a smaller group of real usersto see if

any major problems. Expectations should be set with the usersthat thisis a"beta" not a
"live" situation. The users should be prepared that problems are likely to happen and they
should be able to tolerate downtime of the system for several days or longer to correct any
problems that are found.

Perform a controlled roll-out. After the beta test has run for sufficient time with no major
problems then increase the # of users.

Now go live! After the controlled-rollout has run for sufficient time with no major problems
then go live.
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4 Migration FAQ

4.1 How do | rapidly build a new Web application with Appeon
PowerServer?

Step 1: Create a new application.

Quickly create a new PowerBuilder Client/Server application workspace in your
PowerBuilder IDE.

Step 2: Code for the application.

Enable the Appeon Code Insight tool that isincluded in PowerServer Toolkit, and then write
code. With the Code Insight, you can get instant information on whether the new codeis
supported by Appeon.

Step 3: Migrate the application automatically with Appeon Deployment Wizard.

After previous steps, your PowerBuilder application now contains features that are 100%
supported by Appeon. Y ou do not need to modify any unsupported features. Y ou can easily
migrate your Client/Server application to Browser/Server application with the deployment
wizard in PowerServer Toolkit toolbar.

4.2 Does Appeon support every PowerBuilder feature?

The current version of Appeon does not support all PowerBuilder syntax. Unsupported
PowerBuilder syntax fallsinto two categories:

Category 1. PowerBuilder features that are Client/Server architecture specific, and cannot be
implemented in n-Tier Web applications.

Unsupported features in this category must be reworked for n-Tier architecture.

Category 2: PowerBuilder features that are currently unsupported by Appeon, but will
possibly be supported in the future.

Section 3.8, “Modifying unsupported features’ gives you high-level instructions on how
to modify unsupported features. Chapter 6, Wor karounds for Unsupported Featuresin
Workarounds & API Guide provides examples on some common unsupported features and
ways to work around them.

4.3 Do Appeon-deployed Web applications support external
resources?

Appeon supports using external resources in Web applications, such as INI and image files,
OCX and OLE controls, etc.

4.4 Why classify my application into types?

The PowerBuilder-to-Web process can be simple or complex depending on the type of
application being migrated. Appeon provides guidelines for different types of applications.
Once you have identified the type of application, follow the specific guidelines to get your
application on the Web even faster.
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4.5 What are the different application types?
PowerBuilder applications can be classified as one of three types.

Type 1 applications meet the following requirements and can be automatically deployed to
the Web:

» The application does not contain any functionality that cannot be implemented on the Web.
» The application does not contain any unsupported features.

» Thesetypes of applications tend to be below 50 MB (application PBLs including
Framework).

Type 2 applications contain some functionality that cannot be implemented on the Web,
and/or some unsupported features. The size of the application may be large, and/or the user
objectsin the application may have complex interdependencies. Modify the objects or codein
the application and make it compliant with Supported PB Features for PowerServer Web.

Type 3 applications contain functions that cannot be implemented on the Web but are critical
to the functionality of the application and have very complex frameworks that do not align
well with Appeon supported features, such as PFC-based applications. Depending on the
business requirements and project scope, the devel oper can leverage the RAD capabilities

of PowerBuilder to get an application on the Web much faster than atypical J2EE or .NET
rewrite while preserving the rich PowerBuilder GUI.

4.6 What are the recommendations for converting the different
application types?
The following are recommendations for handling the different types of applications.

Type 1 applications: Thistypeis ready to be migrated. There is no additional work to

do. Appeon reads the PowerBuilder PBLs and generates the n-Tier Web application. The
Web application will have Datawindows, business logic, and Ulsidentical to the original
PowerBuilder application.

Type 2 applications: The developer needs to remove the unsupported features and Client
Server specific functions from the application that cannot be implemented on the Web to
ensure that the Web deployed application functions in the same manner as the PowerBuilder
application. If the application is large and complex, Appeon suggests splitting it into smaller
applications to simplify the debugging of the application. Remove as many minor and
unnecessary features as possible. Simplify the code and object interdependencies to make the
application more straightforward. The DatawWindows and a good portion of the PowerBuilder
source code can be utilized. The amount of PowerBuilder source code that can be reused
depends on the actual application's complexity and the user's requirements.

Type 3 applications: These generally cannot be migrated to the Web as-is, but the
DataWindows and other useful objects can be exported and used to rapidly build amore
straightforward PowerBuilder application using standard PowerBuilder programming.

The ultimate aim of the guidelinesisto help you modify the PowerBuilder application and
make it well supported by Appeon. The existing Datawindows may be used. Depending on
the application type, modify afraction, a part, or all of the PowerBuilder source code.
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4.7 What are the basic requirements for rewriting complex
applications?

The Supported PB Features for PowerServer Web outlines a set of requirements and
recommendations that should be followed. See Supported PB Features for PowerServer
Web for more information. Essentially, you must re-code portions of the application to
make the application more straightforward (by, for example, removing complex object
interdependencies and reducing the number of DataWindows and DataStores in a given
Window).

4.8 When would | need to modularize my application?

If the applicationisaType 2 or Type 3 application, you may need to split the application
into smaller applications and deploy them separately depending on the actual migration
reguirements.

4.9 What are the benefits of modularizing my application?

The following are advantages of splitting an application into smaller applications:

Smaller applications have better performance when deployed to the Web.

It is easier and more efficient to debug smaller applications and rework the unsupported
features.

It allows several developersto work on one project simultaneously and improves devel oper
productivity because one or more devel opers can specialize on particular modules. The
modules can each be deployed to the Web and linked together through a unified HTML
interface.

4.10 What are the basic principles for modularizing an application?

The following are the basic principles for splitting an application into smaller applications
(modularizing):

The functionality of each small application should be independent from the others. Each
application to be deployed should be able to execute an independent and practical task.
Following this principle, it is better to integrate closely related functional pointsin asmall
application and remove the loose object references. For example, to split a purchase order
application into smaller parts, the order management logic (module) can be placed in a
small application and the relevant supplier information management logic in another small
application.

On the basis of thefirst principle, try to balance the complex objects evenly across all the
small applications.

The applications should be as small as possible.

4.11 Can you give an example of the modularization process?

The following example highlights the process of modularization of an application:
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A purchase order application needs to be deployed to the Web. It isalarge and complex
application that provides the following functionalities at a high-level:

» Order Input

Order Management

Supplier Management

Resource Planning

Reporting

According to business requirements, the most urgent application functions that must
be brought on to the Web as soon as possible are Order Input, Order Management, and
Reporting.

Based on the above business requirements, the first phase of the conversion process should
involve extracting the Order Input, Order Management and Report functionalities from the
original application and importing them back into PowerBuilder. This creates a new smaller
application.

Using Supported PB Features for PowerServer Web and Appeon Code Examples, you can
work around or modify the unsupported source code in the smaller application to bring it into
compliance and deploy it to the Web.
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5 Enhancing an application with Web or
Appeon features

The following table gives you a general idea on how to enhance applications with Web or

Appeon features.

Table5.1: Enhance a deployed application with Web/Appeon features

Type of the

Feature

Description of the Feature

How to add it in the deployed
application

Typical Web |+ Accessibility of the application viaURLSs | Such features are automatically
features or SAP Sybase Enterprise Portal added in the deployment
application, with no need for
» Firewall compatibility. The Web file any specia coding.
iISHTTP .
transfer is over port 80 Refer to Section 5.3, “Loading
« SSL and digital certificate security an application in SAP Sybase
Enterprise Portal” for details
« Superior scalability. Typica applications |on how to load the application
support 60-80 concurrent users per server |in Enterprise Portal.
CPU that maps to 300-500 named/end
users per server CPU.
* More...
PowerServer | Use PowerServer open interfaces to manage | The interface(s) should be
open Appeon-deployed Web applicationsusing | called in the PowerBuilder
interfaces PowerBuilder code. application to take effect in the

deployed application.

Refer to Section 5.1
“PowerServer open interfaces’
for details.

Appeon client

Use Appeon client functions to get client

The client function(s) should

Connectivity to Java/lEJB, PB NVO, C/C
++ DLL, COM/ActiveX Components on
Application Servers

Connectivity to Web Services, J2EE,
and .NET

functions information or server information, or be called in the PowerBuilder
use Appeon enhanced featuresin the application to take effect in the
applications. deployed application.
Refer to Section 5.2, “ Appeon
client functions” for details.
Web » Providesflexible & open Java, .NET, & |There are different ways for
integration Web Services integration implementing the integration

of an Appeon Web application
with other applications.

Refer to Section 5.4, “Single
sign-on” and Section 5.5,
“Integrating Appeon Web
applications with JSP/ASP” for
details.
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Typeof the Description of the Feature How to add it in the deployed

Feature application
» Connectivity to Messaging Queues
(MQSeries, IMS, etc.)

5.1 PowerServer open interfaces

PowerServer open interfaces give you the opportunity to manage services provided by
PowerServer through PowerBuilder code. Y ou can easily manage A ppeon-deployed Web
applications with the open interfaces bel ow:

» getAllClients

» getAllSessions

* getSessionByID

» getSessionCount

* killAllSessions

* killSessions

* rollbackAll Transactions

5.1.1 Description of the open interfaces

Refer to Chapter 5, Power Server open interfaces in Workarounds & APl Guide for the syntax
of PowerServer open interfaces. Note that you can write code for calling the interface in the
PowerBuilder application, but the code does not take effect in the PowerBuilder application;
it only takes effect in the Appeon-deployed application.

5.1.1.1 getAlIClients

getAllClients gets the | P addresses of all client machines which corresponds to the active
sessions that are opened for the specified application in the specified PowerServer.

5.1.1.2 getAllSessions

getAllSessions returns the detail information of active sessions with XML format, which are
opened for the specific application in the specific PowerServer.

5.1.1.3 getSessionByID
getSessionBYID returns the detail information of the specified session with XML format.

5.1.1.4 getSessionCount
With getSessionCount method, you can get the following three types of information.

» Thetotal number of active sessions opened for the specified application in the specified
PowerServer.
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» Thetotal number of active sessionsin a specified PowerServer.

» Thetotal number of sessions opened for the specified application in a PowerServer cluster.

To get the number of sessionsin a PowerServer cluster, you need to first configure the
cluster in AEM.

By using the GetSessionCount method, you can easily get the total number of active sessions
in a specified PowerServer using PowerBuilder code and apply the information in other

open interfaces such as Kill Session to manage the sessions. For example, you can first call
GetSessionCount and then call KillSession in the PowerBuilder application to make the
deployed application kill all sessionsin PowerServer when there are up to 100 active sessions
in the server.

5.1.1.5 killAllSessions

killAllSessions kills all active sessions in a PowerServer or an PowerServer cluster and rolls
back all associated transactions. To kill all sessionsin a PowerServer cluster, you need to first
configure the cluster in AEM.

5.1.1.6 killSessions

kill Sessions kills the specified session(s) in a PowerServer or a PowerServer cluster and rolls
back the associated transactions. To kill sessionsin a PowerServer cluster, you need to first
configure the cluster in AEM.

5.1.1.7 rollbackAllTransactions

rollbackAll Transactions rolls back al transactions in a PowerServer or a PowerServer cluster.
To roll back all transactions in an PowerServer cluster, you need to first configure the cluster
in AEM.

5.1.2 Applying PowerServer open interfaces in Appeon-deployed applications

To apply a PowerServer open interface in an Appeon-deployed Web application, you only
need to perform the following two steps.

1. Call the PowerServer open interface in the PowerBuilder application. For how to call
PowerServer open interfaces in a PowerBuilder application, refer to Section 5.2, “Calling
PowerServer open interfaces via EJB component” in Workarounds & API Guide or
Section 5.3, “ Calling PowerServer open interfaces via .NET component” in Workarounds
& API Guide.

2. Deploy the PowerBuilder application to PowerServer the same way you would deploy a
normal PowerBuilder application.

5.2 Appeon client functions

Appeon client functions are a set of PowerBuilder functions encapsulated in Appeon
workaround PBLs. Y ou can add Appeon client functions in your PowerBuilder applications
to achieve the following in Appeon-deployed applications:

* Get client information, such as the |P address, or the browser type of the client
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» Get server information, such as total numbers of the active session on a cluster or asingle

PowerServer.

» Use Appeon Web enhanced features, such as Appeon Datawindow menu, PDF print, and

LDAP Logon.

5.2.1 Description of Appeon cl

ient functions

The following table provides the client functions and their return values. Note that some
Appeon client functions are just interfaces provided by the Appeon system; they have empty
function bodies and empty return values for the PowerBuilder applications.

Table5.2: Client functionswith their return values

Functions

Return value when
executed in PowerBuilder

Return value when
executed in Appeon

application

This function has no effect
in PowerBuilder.

AppeonGetAppeonUserName() | None. The user name typed into
This function has no effect the Appeon Login didog.
in PowerBuilder.

AppeonGetBrowserVersion() None. The version of the Internet

Explorer browser that
runs the current Web
application.

AppeonGetClientl D()

The unique session
identifier for PowerBuilder
client.

The unique session
identifier for the Web
client.

AppeonGetCacheDir()

None.

This function has no effect
in PowerBuilder.

The cache directory that is
used by the current Web
application.

AppeonGetClientl P()

The | P address of
PowerBuilder client

The IP address of the Web
client.

attribute)

This function has no effect
in PowerBuilder.

machine.

AppeonGetClientType() "PB" "WEB" if the application
runs on a Web browser,
or "MOBILE" if the
application runson a
mobile device.

AppeonGetHttplnfo (string None. The HTTP header

information from a
particular request.

AppeonGetl EHandl ()

None.

This function has no effect
in PowerBuilder.

The Internet Explorer
handle for the current Web
application.

AppeonGetlEURL ()

None.

The URL of the current
Appeon application.
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Functions

Return value when
executed in Power Builder

This function has no effect
in PowerBuilder.

Return value when
executed in Appeon
application

AppeonGetOSType()

The type of the OS that
runs the PowerBuilder
client application.

The type of the OS that
runs the current Web
application.

AppeonGetRemainingdays
(String as_type, ref string
as _error)

None.

This function has no effect
in PowerBuilder.

The remaining day(s) of
license or technical support.

AppeonGetServer Type()

None.

This function has no effect
in PowerBuilder.

Returns 1 if the application
runs on an PowerServer
that isinstalled to a J2EE
Server (such as WebL ogic).

Returns 2 if the application
runs on an PowerServer
that isinstalled to a
Microsoft .NET Framework
\IIS.

Appeonlsln64Browser

None. This function has no
effect in PowerBuilder.

Returns "true" if the
application runs on a 64-bit
|E browser. Returns "false"
if the application runson a
32-bit |E browser.

AppeonLDAPLogon (string

None.

Login username and

adw_dw, Integer nx, Integer ny)

as_username, string as_password) This function has no effect password for the LDAP
in PowerBuilder. SerVer.
AppeonPopMenu (Datawindow | None. None.

This function has no effect
in PowerBuilder.

At the execution

of the function,
AppeonDatawindow menu
Isdisplayed at the specified
position on the specified
DatawWindow control.
AppeonPopMenu has
higher priority than
AppeonPopMenuOn.

AppeonPopMenuOn
(Datawindow adw_dw, Boolean
ab_show)

None.

This function has no effect
in PowerBuilder.

None.

At the execution

of the function,
AppeonDatawWindow menu
pops up when you right
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Functions

Return value when
executed in Power Builder

Return value when
executed in Appeon
application

click on the specified
Datawindow.

AppeonPrint2File (datawindow
adw, string asoutpath, string
asoutname, long alouttype)

None.

This function has no effect
in PowerBuilder.

Integer.

Returns 1 if it succeeds

in printing the specified
Datawindow/DataStore as
aPDF or an image file of
BMP, JPG or GIF format,
otherwise, returns -1.

AppeonSwitchReal TimeCalc

None. This function has no
effect in PowerBuilder.

Returns O (default value) if
need to perform real-time
calculation. Returns 1 if no
need to perform real-time
calculation.

5.2.2 Using Appeon Client functions

Although the main purpose of Appeon Client functionsisto implement certain functionalities
in Appeon-deployed applications, you must call the functions in your PowerBuilder
application to make the functions effective.

To use Appeon Client functions in Appeon-deployed applications, refer to Section 2.3.2,
“Appeon Client Functions’ in Workarounds & APl Guide for more detail.

5.3 Loading an application in SAP Sybase Enterprise Portal

SAP Sybase Enterprise Portal (EP) is an open and scalable portal framework that provides
an intuitive, secure and customized environment for end-users; rapid development and
deployment tools for devel opers; and an easy-to-use console for administrators. Appeon-
deployed applications can run in SAP Sybase Enterprise Portal or Unwired Accelerator.

5.3.1 Restrictions on supporting Enterprise Portal

Appeon supports Enterprise Portal 6.1 Info Edition and Enterprise Edition. Be aware of the
following restrictions when you load Appeon Web applications in Enterprise Portal:

* Only ONE Appeon Web application can be viewed inside one EP Page. Multiple Appeon
Web applications can be viewed within multiple pages. For example, you can have Sales
App Demo on one EP Page and A ppeon Code Examples on another EP Page and both

function correctly.

» Exiting from Appeon Web applications do not close Internet Explorer.

* Only one response window is allowed for an Internet Explorer browser at agiven time.
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5.3.2 Tasks required to load the application in Enterprise Portal

Y ou need to perform the following four tasks to get a deployed application loaded in the
portal after the application migration:

Task #1: Add the application into a portlet. Create an HTML element in the portlet and assign
the URL of the Appeon-deployed application to the HTML element.

Task #2: Add the application into a page. Create a new page, add the application into it, and
approve the application.

Task #3: Add the page into a page group. Create a new page group and add the page created
in task #2 into the page group.

Task #4: Create accounts for viewing the application. Create accounts and assign rights to the
accounts for running the application.

For step-by-step instructions on conducting each of the preceding tasks, refer to the
relevant documentation provided by SAP Sybase Enterprise Portal (available at http://
www.sybase.com/products/archivedproducts/enterpriseportal /techni cal support).

5.4 Single sign-on

Single sign-on can be implemented in the Appeon deployed Web applications using the
following two methods:

» Using aserver component to manage user information
* Applying command line argument

For detailed steps of using the above methods, refer to Section 7.10, “How to log in the
Appeon Web application with single sign-on” in Workarounds & API Guide.

5.5 Integrating Appeon Web applications with JSP/ASP

Y ou can integrate Appeon Web applications with JISP/A SP applications using the following
three methods:

» Applying Appeon CommandParm and Hyperlink features
» Using Internet Explorer frame
* Integration through intermediate n-Tier server

For detailed steps of using the above methods, refer to Section 7.14, “How to integrate
Appeon Web applications with JSP/ASP” in Workarounds & API Guide.
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6 Processing PFC Applications

Appeon supports most PFC features. As such, under most situations the existing PFC code
can also work under the Appeon environment without any modifications. However, there
are afew features that are not supported. For that handful of unsupported features, Appeon
would devise aworkaround or aternate implementation of those features. Then, the PFC
framework would be enhanced with any auto-sensing feature that would detect whether the
PFC framework is being run as Client/Server or as PowerServer Web. If Client/Server, then
for those features that Appeon does not support it will execute the origina Client/Server
implementation. If Web, then only for those features that Appeon does not support it will
execute the modified implementation.

After modifying these unsupported features, you can deploy the PFC application just as how
you deploy a normal PowerBuilder application.

6.1 Auto-Sensing Environment

The general idea of making PFC work for both PowerBuilder and Appeon is calling a global
function to judge the application’s running environment. This global function will help to
judge whether to run the original PFC code or Appeon compliant code.

The global function "appeongetclienttype” isincluded in the Appeon Workarounds PBL. Y ou
will need to first add the appeon_workarounds.pbl library to your application and then call
the appeongetclienttype global function. For detailed instructions, refer to Chapter 2, Appeon
Workarounds PBL Reference in Workarounds & API Guide.

6.2 Suggested Modifications to PFC

The following sections give detailed suggestions for how to modify current PFC codes so
that those Appeon unsupported or modified PFC features work in both PowerBuilder and
in Appeon. Code modifications are only made where absolutely necessary and the "Auto-
Sensing Environment” feature will be used to ensure under no circumstance are existing
Client/Server users affected by any Appeon modifications. Appeon suggested modification
will follow the following format:

| F appeongetclienttype() = "PB" then
Original code in PFC

el se

Appeon conpliant code in PFC

End if

6.3 Unsupported user objects

PFC framework contains the following user objects as unsupported (in the last two lines):
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Figure 6.1: Unsupported User objectsin PFC

Service Pipeline POlestream Olestorage Contextkeyword
¥ ¥ Yy Yy Y
n_srv n_pl n_ocstm n_ostg n_cxk
Y J’ ¥ ¥ i
pfc_n_srv pfc_n_pl pfc_n_ostm pfc_n_ostg pfc_n_cxk

Recommendation: Although these user objects are defined, they are not referred to in PFC
framework, therefore you do not need to modify them and you should avoid referring to these
objectsin your application.

6.4 Unsupported standard class objects
These four standard class objects are unsupported:

» Contextinformation

* Classdefinition

» Scriptdefinition

» Variabledefinition

Recommendation: Avoid referring to the following object functions, this can reduce the
impact on the functionality:

» pfcmain.pbl\pfc_w_master\of_setresize

» pfcapsrv.pbl\pfc_n_cst_security\of _setsecurity
 pfcapsrv.pbl\pfc_n_cst_ metaclass\of _findmatchingevent

» pfcapsrv.pbl\pfc_n_cst_metaclass\of _findmatchingvariable
» pfcapsrv.pbl\pfc_n_cst_metaclass\of _getancestorclasses

» pfcapsrv.pbl\pfc_n_cst_metaclass\of _isfunctiondefined

» pfcapsrv.pbl\pfc_n_cst_metaclass\of _iseventimplemented

» pfcapsrv.pbl\pfc_n_cst_metaclass\of_iseventdefined
 pfcapsrv.pbl\pfc_n_cst_ metaclass\of _isancestorclass

If you really need to use Classdefinition, try to use the following workaround:
Original script:

I b_defined = inv_netacl ass. of _i sFuncti onDefi ned &
(I po_tocheck. C assDefinition, "of_PostUpdate", |s_args)
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Modified script:

If | po_tocheck. Tri gger Event (" pfc_descendant") = 1 Then
| b_defined = True

El se
| b_defined = Fal se

End if

6.5 Unsupported object properties

Table 6.1: Unsupported object propertiesthat need no modification
Object Properties Calls Suggestion

Application ToolbarUserControl Need no modification.

ToolbarText
ToolbarPopMenuText
DwMessageTitle
DdeTimeOut
OLEControl ClassShortName
ClassLongName
Transaction Lock

Sqlreturndata
Message Returnvalue

Need no modification.

Need no modification.

Need no modification.

Number
Handle
Connection Trace

Need no modification.

Options

NIN NP PP P WP WO

Connectstring
GraphicObject Classdefinition

[EEN

Need no modification.

Table 6.2: Unsupported object propertiesthat need modification

Object Properties Calls | Suggestion

Window Classdefinition 1 Need modification.

Calling this property has no impact on the
functionality. However, it has impact on the position
and size of the control in a DataWindow when the

DatawWindow is zoomed in or zoomed out. Refer to the
detailed information below.

DETAILED INFORMATION

Location: Of _setresize(boolean) function of
pfc_w_master in pfcmain.pbl

Appeon Unsupported Code: Lcd class=
this.ClassDefinition

Line Number: 45
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Object Properties Calls | Suggestion

Change the code to:

i f AppeonCGetdientType( ) = 'PB then
cl assdefinition | cd _class
lcd class = this.Cd assDefinition
li _vars = UpperBound ( |cd_cl ass. Vari abl eLi st )
For Ii_ v =1to li_vars
If lcd class.VariableList[li_v].Name = "wi dth"
then &
li_origw dth = |nteger
( lcd class. VariableList[li_v].InitialValue )
If lcd class. VariableList[Ii_v].Nane = "hei ght"
then &
I'i _origheight = Integer
( lcd class. VariableList[li_v].InitialValue )
If li _origwidth > 0 And |i_origheight > 0 then
&

Exi t
Next
inv_resize.of _SetOrigSize ( |i_origw dth,
I'i _origheight )
el se
inv_resize.of _SetOrigSize ( this.wdth,
t hi s. hei ght )
end if

PowerObject| Classdefinition 7

Need modification

This property is often used for detecting a function of
aobject.

It is suggested to modify the whole code segment,
calling a function no matter whether it exists or not.
Refer to the detailed information below.

DETAILED INFORMATION

Location 1: Of_validation(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lcd class=
this.ClassDefinition

Line Number: 123
Change the code to:

i f AppeonCetCientType( ) = 'PB then
| b_defined =
i nv_net acl ass. of i sFuncti onDefi ned
& (I po_tocheck. C assDefinition,
"of Validation", |s_args)
el se
| b_defined = True
End if

Location 2: Of _updatespending(powerobject) function
of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of _isFunctionDefined
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Object Properties Calls | Suggestion

(Ipo_tocheck.ClassDefinition, "of _UpdatesPending”,
Is args)

Line Number: 130
Change the code to:

i f AppeonCGetdientType( ) = 'PB then
| b_defined =
i nv_net acl ass. of _i sFuncti onDefi ned
& (I po_tocheck. d assDefinition,
"of Updat esPendi ng", |s_args)
El se
| b_defined = True
End if

Location 3: Of_updateprep(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined

= inv_metaclass.of _isFunctionDefined
(Ipo_tocheck.ClassDefinition, "of _UpdatePrep”,
Is args)

Line Number: 122
Change the code to:

i f AppeonCGetCientType( ) = 'PB then
| b_defined =
i nv_net acl ass. of _i sFuncti onDefi ned
& (I po_tocheck. d assDefinition,
"of Updat ePrep", |s_args)
el se
| b_defined = True
End if

Location 4: Of _update(powerobject,bool ean,bool ean)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of _isFunctionDefined
(Ipo_tocheck.ClassDefinition, "of _Update”, Is args)

Line Number: 145
Change the code to:

i f AppeonCGetdientType( ) = 'PB then
| b_defined =
i nv_net acl ass. of _i sFuncti onDefi ned
& (I po_tocheck. d assDefinition, "of Update",
I s_args)
El se
| b_defined = True
End if

However, with the suggested changes made, only
DataWindows placed directly on windows would
update. For Datawindows placed on tab pagesto
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Object Properties Calls | Suggestion

update correctly, add the code to the Case statement in
the function to call of _update() on UserObject and Tab
controls to make updates on tab pages work correctly.

Location 5: Of_postupdate(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined

= inv_metaclass.of _isFunctionDefined
(Ipo_tocheck.ClassDefinition, " of PostUpdate ",
Is args)

Line Number: 123
Change the code to:

i f AppeonCGetCientType( ) = 'PB then
| b_defined =i nv_netacl ass. of _i sFuncti onDefi ned
& (I po_tocheck. d assDefinition,
"of Post Update", |s_args)
el se
| b_defined = True
End if

Location 6: Of_isselfupdati ngobj ect(powerobject)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined
= inv_metaclass.of _isFunctionDefined
(apo_control.ClassDefinition, "of_Update”, Is_args)

Line Number: 60
Change the code to:

i f AppeonCGetdientType( ) = 'PB then
| b_defined =i nv_netacl ass. of _i sFuncti onDefi ned
& (apo_control . d assDefinition, "of Update",
I s_args)
el se
| b_defined =True
End if

Location 7: Of_accepttext(powerobject,boolean)
function of pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: Lb_defined

= inv_metaclass.of _isFunctionDefined
(Ipo_tocheck.ClassDefinition, "of AcceptText",
Is args)

Line Number: 128

Change the code to:

i f AppeonCGetCientType( ) = 'PB then
| b_defined =
i nv_net acl ass. of _i sFuncti onDefi ned
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Object Properties

Calls | Suggestion

& (I po_tocheck. d assDefinition,
"of _Accept Text", |s_args)
el se
| b_defined = True
End if

Datawindow| Hsplitscroll 1
control

Need modification.
Refer to the detailed information below.

Location: Of_position(dragobject,boolean) function of
pfc_n_cst_dropdown in pfcapsrv.pbl

Appeon Unsupported Code: If Idw_object.hsplitscroll
Line Number: 237
Change the code to:

i f AppeonCetCientType( ) = 'PB then
li_hsplit = Integer (|Idw_object.Describe
(" Dat aW ndow. Hor i zont al Scrol I Split"))

Ii _hposl = Integer (|dw_object.Describe

(" Dat aW ndow. Hor i zont al Scrol | Posi tion"))

Ii _hpos2 = Integer (|dw_object.Describe

(" Dat aW ndow. Hor i zont al Scr ol | Posi ti on2"))
i f | dw_object.hsplitscroll then

if li_hsplit >4 and |i_pointerx > |i_hsplit
t hen
li _hpos = li_hpos2 - |i_hsplit -
of _Get Systentetti ng (DW HSPLI TBAR_ W DTH)
el se
i _hpos = |i_hpos1
End if
el se
Ii _hpos = li_hposl
End if
el se
l'i _hpos = 0
End if

6.6 Unsupported object functions

Table 6.3: Unsupported object functions that need no maodification

Object Functions Calls Suggestion
NonVisual Object GetContextService |1 Need no modification.
Window Settool bar 5 Need no modification.
Gettoolbar 3
Gettoolbarpos 2
Settoolbarpos 2
SingleLineEdit Canundo 1 Need no modification.
RichTextEdit Canundo 1 Need no modification.
OLEControl UpdateLinksDialog |1 Need no modification.
PasteSpecial 1
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Object Functions Calls Suggestion

Paste 1

Cut 1

Copy 1
EditMask Canundo 1 Need no modification.
DataStore ReselectRow 1 Need no modification.

6.7 Unsupported object events

Table 6.4: Unsupported object eventsthat need no modification

Object Events Suggestion

RichTextEdit PrintHeader Need no modification.
FileExists

ListView Sort Need no modification.

Application SystemError Need no modification.

6.8 Unsupported system functions

Table 6.5: Unsupported system functionsthat need no modification

System functions Calls Suggestion
ShowHelp 18 Need no modification.
FindClassDefinition 6 Need no modification.

6.9 Unsupported Shared variables

Table 6.6: Unsupported shared variablesthat need no modification
Shared variables Calls Suggestion

snv_property 5 Need no modification.

6.10 Unsupported Function not found

Table 6.7: Unsupported functions that need no modification
Functions Suggestion

dwObject.GetChild 1 Need no modification.

Table 6.8: Unsupported functionsthat need no modification
Functions Calls Suggestion

dwODbject.Print |3 Need modification. Refer to the detailed information below.
DETAILED INFORMATION

Location 1: Pfc_print() event of pfc_u_dw in pfcmain.pbl
Appeon Unsupported Code: Li_rc = Ids_selection.Print(true, true)
Line Number: 75
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Functions Calls Suggestion

Change the code to:

if Isvalid (lds_selection) then
If AppeonGetClientType( ) = 'PB then

li rc = 1lds_selection.Print (true, true)
el se

li rc = 1lds_selection.Print (true)
end if

destroy | ds_sel ection

el se

If AppeonGetClientType() = 'PB then
li rc =this.Print (true, true)

el se

li rc =this.Print (true)

end if

end if

Location 2: Pfc_print() event of pfc_n_dsin pfcmain.pbl

Appeon Unsupported Code: Li_rc = |ds_selection.Print(true, true)
Line Number: 87

Change the code to:

if Isvalid (lds_selection) then

if AppeonCGetdientType( ) = 'PB then
i _rc =lds_selection.Print (true, true)

el se
li rc = 1lds_selection.Print (true)
end if
destroy | ds_sel ection
el se

If AppeonGetClientType() = 'PB then
li rc =this.Print (true, true)

el se

li rc =this.Print (true)

end if

end if

6.11 Unsupported calls

Table 6.9: Unsupported calls

Unsupported calls  Suggestion

Cdlling the

SQL Preview
event by Update
or ReselectRow
functionsis
unsupported.

Need modification. Refer to the detailed information bel ow.
DETAILED INFORMATION

Location: Of _setupdatestyle function of the
Pfc_n_cst dwsrv_linkage object in pfcdwsrv.pbl

Add the following code:

if ai_style = TOPDOAN _BOTTOMUP t hen
ai _style = BOTTOMUP

end if

if ai_style = BOTTOMUP_TOPDOMN t hen
ai _style = BOTTOMUP

end if
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Unsupported calls  Suggestion

Dynamically calling | Need modification. Refer to the detailed information below.

overloaded function | e || ED INFORMATION
of an uncertain object

is unsupported. Location: Of _update(powerobject,boolean,boolean) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: li_rc = Ipo_tocheck.Function Dynamic
of Update (ab_accepttext, ab_resetflag, |po_updaterequestor)

Line Number: 147

Change the code to:
u_dw | dw update
n_ds | ds_updat e
u lvs Il vs_updat e
u tvs | tvs_update

i f AppeonCetCientType( ) = 'PB then
If I b _defined then
li_rc = | po_tocheck. Dynam c of _Update (ab_accepttext,
ab_resetfl ag, | po_updaterequestor)
if li_ rc <0 Then
Return -1
Cont i nue
End if
el se
if | b _defined then
Choose Case Typeof ( | po_tocheck)
Case Dat aW ndowl
| dw_update = | po_t ocheck
li_rc = |l dw update. of _Update (ab_accepttext,
ab_resetfl ag, | po_updaterequestor)
if li_ rc <0 then Return -1
Cont i nue
Case ListView
Il vs_update = | po_t ocheck
li_rc = 1lvs_update.of Update (ab_accepttext,
ab_resetfl ag, | po_updaterequestor)
If Ili rc <0 Then return -1
Cont i nue
Case TreeVi ew
Itvs_update = | po_t ocheck
li_rc= Iltvs_update. of Update (ab_accepttext,
ab_resetfl ag, | po_updaterequestor)
if li_ rc <0 Then return -1
Cont i nue
Case Dat aSt or e!
| ds_update = | po_t ocheck
l'i _rc= |lds_update.of Update (ab_accepttext, ab_resetfl ag,
| po_updat er equest or)
if li_ rc <0 Then return -1
Cont i nue
End choose
End if
end if
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6.12 Differently behaved features

Table 6.10: Differently behaved features

Object Suggestion

MDI frames

WorkSpaceX

WorkSpaceY

Need modification. Refer to the detailed information bel ow.

Location: Of _setposition () function of pfc_w_statusbar in
pfcwnsrv.pbl

Line Number: 72
Suggested Modifications:

Step 1: Add the rect structure variable to the pfcwnsrv.pbl
with the following format.

global type rect from structure
long left

long top

long right

long bottom

end type

Step 2: Declare alocal external function in the
pfc_w_statusbar.

Function long GetWindowRect (long hwnd , ref rect |pRect)
Library "user32"

Step 3: Rewrite the scriptsin the Current PFC into the
following:

long || _bottonpos, Il _rtn, |l _TopPos, |l _LeftPos
rect Ir_WnRect
Il _rtn = getwi ndow ect (handle (iw_parentw ndow),
I r_WnRect)
Il _LeftPos = PixelsToUnits (lr_WnRect. Left,
XPi xel sToUni ts!)
Il _TopPos = Pixel sToUnits (lr_WnRect. Top,
YPi xel sToUni ts!)
I'l _bottonpos = PixelsToUnits (Ir_WnRect. bottom
YPi xel sToUni ts!)
| f AppeonGetClientType( ) = 'PB then
/] The Y Position of the Status Bar is the Bottom of
[/l the Franme W ndow mi nus the M croHel pHei ght m nus
/] the M croHel pBorder Hei ght .
Il _microhel p_ypos = &
(i w_parentw ndow.y + iw_parentw ndow. hei ght +
li_ypos_extra) - &
(i w_parentw ndow. ndi _1. mi cr ohel phei ght +
i i _borderhei ght)

/1 The desired X Position of the Status Bar is the
/1l Frame Right End minus the StatusBar wi ndow. Also
/] subtract the extra spaci ng on w n95.

I | _desiredstatubar_xpos = &
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Object Suggestion

i w_par entw ndow. x + i w_parentw ndow. wor kspacew dt h()
+

& ii_borderwidth - (ii_w nmaxwidth + 12 +

|'i _xpos_extra)

[/l The Franme X Position.
I'l _frame_xpos = iw_parentw ndow. x +
(2*ii _borderw dth) + 16
if Il _desiredstatubar_xpos < || _franme_xpos then
/] Status Bar would extend to the left of the frane.
this. mve(ll _frame_xpos , |l _mnicrohel p_ypos)
/1 Make the StatuBar the width of the frame.
this.wi dth = workspacew dt h(i w_parentw ndow) - (20 +
|'i _xpos_extra)
el se
/!l Normal as |large as defined Status Bar w ndow.
thi s. move(l | _desiredstatubar_xpos |,
I'l _m crohel p_ypos)
this.width = ii_w nmaxw dth
end if
el se
[/l The Y Position of the Status Bar is the Bottom of
/1 the Franme W ndow m nus the M croHel pHei ght m nus
/] the M croHel pBorder Hei ght .
Il _mcrohel p_ypos = &
(I'l _TopPos + iw_parentw ndow. hei ght + |i_ypos_extra)

& (i w_parentw ndow. ndi _1. mi cr ohel phei ght +
i i _borderheight)
/] The desired X Position of the Status Bar is the
/1 Frame Right End minus the StatusBar w ndow.
[l Also subtract the extra spacing on w n95.
I | _desiredstatubar_xpos = &
Il _LeftPos + iw_parentw ndow. wor kspacewi dth() + &
ii_borderwidth - (ii_winmaxwidth + 12 + |i_xpos_extra)
Il _frame_xpos = || _LeftPos + (2*ii_borderwidth) + 16
if Il _desiredstatubar_xpos < || _frame_xpos then
/] Status Bar would extend to the left of the frame.
this. mve(ll _frame_xpos , |l _bottonpos - 70)
/1 Make the StatuBar the width of the frame.
this.width = iw _parentw ndow. wor kspacewi dth() - (20 +
i _xpos_extra)
el se
/!l Normal as |large as defined Status Bar w ndow.
thi s. move(l | _desiredstatubar_xpos , || _bottonpos -
70)
this.width = ii_w nmaxw dth
end if
end if

MDI frames

Resize Service

Need modification. Refer to the detailed information bel ow.

Step 1: Change the wintype property for the w_examplemain
object from MDI to main.

Step 2: Modify the pfc_open event in the
n_exampleappmanager of the appexmfe.pbl as shown below:

Current scriptsin PFC:

Open ( w_exanpl enai n)
Appeon conpliant scripts in PFC
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Object Suggestion

Qpen ( w_frane)
opensheet (w_exanpl emai n, w_frame, 0, |ayered!)

Step 3. Copy the following scripts from the pfc_preopen event
for the w_examplemain object in the appexmfe.pbl to the
pfc_preopen event for the w_frame object in the exmmain.pbl
and then comment out the following scriptsin this event.

/1 Set the frane wi ndow with the applicati on manager.
gnv_app. of _Set Frane(w_exanpl enmai n)

gnv_app. of _Set M cr ohel p(true)

/1 Enable the Status Bar Services

of _Set St at usBar (true)

if IsValid(inv_statusbar) then

i nv_st at usbar. of _Set Bor der Type( 0)

nv_st at usbar. of _Set GapW dt h( 40)

nv_st at usbar. of _Regi ster ('debugsrv', 'bitmap',
dbsvc.gif', 80)
i nv_statusbar. of _Register ('sqlspysrv', 'bitmp',
"sssvcoff.gif', 80)
i nv_st at usbar. of _Regi ster ('debuglogwin', 'bitmp',
"dl gwnoff.gif', 80)
i nv_statusbar. of _Register ('sqglspywin', 'bitmp',

sswi noff.gif', 80)
f gnv_app.ienv_object. Wnl1l6 then
i nv_st at usbar. of _Set GDI (true)
i nv_st at usbar. of _Set User (true)
end if

i nv_st at usbar. of _Set Ti mer (true)
end if

Any ClassName | Need modification. Refer to the detailed information below.
DETAILED INFORMATION

Location: Of _updatespending(powerobject) function of
pfc_n_cst_luw in pfcapsrv.pbl

Appeon Unsupported Code: If ClassName(la_rc) = 'integer’ or
ClassName(la_rc)="long' Then

Line Number: 133

Change the code to:

i f AppeonCetCientType( ) = 'PB then
If ClassNane(la_rc) = '"integer' or CassName(la_rc) =
"l ong" Then

/1 Functionality was found.
If larc <0 Then Return -1
If la_rc >= 1 Then
| b_updat espendi ng = True
I f TypeOF (Il po_tocheck) = DataW ndow! Then

la rc = | po_tocheck. Function Dynam c of _| sRoot ()
| f ClassNanme(la_rc) = 'bool ean' Then
| b_updat espending = la_rc
El se
Return -1
End |f
End |f
End |f

| b_perfornmedtest = True
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Object Suggestion

End |f
el se
If ClassNanme(la_rc) = "integer' or CassName(la_rc) =
"long' or CassNane(la_rc) = 'nunber' Then

If la_rc < 0 Then Return -1
If la_rc >= 1 Then
| b_updat espendi ng = True
If TypeOF (I po_tocheck) = DataW ndow! Then

la_rc = | po_tocheck. Dynam ¢ of _| sRoot ()
I f C assName(la_rc) = 'bool ean' then
| b_updat espending = la_rc
el se
Return -1
End if
End |f
End |f
| b_performedtest = True
End |f
end if
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7 Migration Tutorial

7.1 Introduction

Thistutorial isaseries of five exercises in which you convert and deploy the Appeon tutorial
PowerBuilder application to the Web. By following the tutorial, you will get hands-on
experience in Web migration using Appeon PowerServer.

The Appeon tutorial PowerBuilder application isasmall program involving database
interaction. The application is used in the tutorial as the target PowerBuilder application to be
worked on for a complete Web migration.

Thistutorial isasimplified and practical example of the Appeon Web migration
methodology laid out in Chapter 3, Migration Process. It can serve as a starting point for any
developer who wants to convert their existing PowerBuilder applications. After the successful
migration of the tutorial application, you can try to convert more complex, real PowerBuilder
applications into a more complicated network environment.

How you will proceed:

Lesson 1 |Load the Appeon tutorial application into PowerBuilder.
Lesson 2 | Configure PowerServer Toolkit.

Lesson 3 | Analyzethe tutoria application for unsupported features.
Lesson 4 | Deploy the tutorial application to the Web.

Lesson5 | Run the Web application.

What you will learn:

Lesson1 |How to create a PowerBuilder workspace, load application PBL files, set up an
ODBC data source, and run the application from the PowerBuilder IDE.

Lesson 2 | Add the application profile, the PowerServer profile, the Web server profile, the
deployment profile, the data source profile, and the transaction object mapping
in the PowerServer Toolkit Configuration Wizard.

Lesson 3 | Perform unsupported feature analysis, perform a Full build, and optimize the
tutorial application.

Lesson4 | Deploy the tutorial application to the Web using the Appeon Deployment
Wizard.

Lesson 5 | Run the deployed Web application in the Web browser.

How long it will take:

Y ou can complete the entire tutorial in ninety minutes. Each lesson has also been designed so
that you can stop after any lesson and continue at another time.

7.1.1 Preparing for the tutorial

The following preparations are required before starting this tutorial:
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* Set up one Workstation.

Thistutorial assumes the most simplified network environment. Only one physical
machineis used for al the different rolesin the n-Tier Web architecture: client PC, Web
Server, application server, database server, and developer PC.

Refer to Installation Guide for .NET for specific system requirements.

* Install other required softwares:
Windows Server 2016, 2012 R2, or 2008 R2, Windows 7, or Windows 8/8.1
PowerBuilder 2017
Internet Explorer 8.0 or later, Microsoft Edge, Google Chrome, Mozilla FireFox, or Opera.
Microsoft .NET Framework 4.x & 11S7.5, 8.0, or 10
Note:

1. lISisincluded with Windows, but not installed by default, you will need to install 11S
first.

2. 1S will be used as both the application server and the Web server in this tutorial.

3. If PowerServer isinstalled to the other application servers (such as WebL ogic,
WebSphere, JBoss, or JEUS), you can still follow the stepsin this tutorial for
configuring and deploying the Appeon tutorial application while paying close attention
to the parts specified as working differently for different application servers.

 |Install Appeon PowerServer (on .NET) edition
Install PowerServer and PowerServer Toolkit components. The demo application that the
tutorial uses will be automatically installed during the PowerServer Toolkit installation.

If you intend to install PowerServer and PowerServer Toolkit on different machines, most
of theinstructionsin this tutorial, with the exception of some settings associated with
PowerServer, such as PowerServer profile and data sources, will still be relevant. For
instructions, refer to the PowerServer Toolkit User Guide.

7.1.2 Relevant files

The tutorial will use the following files:

File Name appeontutor.pbl appeontutor.db

Location \appeondemo\Tutorial
(e.g. C:\Users\Public\Documents\A ppeon\Power Server\T ool kit
\AppeonDemo\Tutorial)

Description The PowerBuilder Library The SAP SQL Anywhere database
(application source code) used in | file used for the tutorial application.
the tutorial.
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7.2 Loading the Tutorial PowerBuilder Application

Thistutorial starts with two files: appeontutor.pbl and appeontutor.db. The appeontutor.pbl
file contains the source code for the Appeon tutorial PowerBuilder application. First, follow
the instructions to make the tutorial application run in PowerBuilder.

In this section, you will learn how to:

e Create a new PowerBuilder Workspace

* |Load thetutorial PBLs into the Workspace

e Configure the ODBC data source for the tutorial application

* Run the tutorial application

7.2.1 Creating a Workspace

Y ou can have only one PowerBuilder Workspace open at atime, but you can add as many
targets or applications to the Workspace as you want, including opening and editing objects
in multiple targets.

To create a new Workspace for the Appeon tutorial PowerBuilder application:

Step 1: Start PowerBuilder. The PowerBuilder IDE starts with the PowerServer Toolkit
loaded.

Figure 7.1: Power Server Toolkit tool bar loaded into Power Builder

B
File Run Tools Window Help

eI N =Y N T e T EE T
HEEE IR TEY IR IR
x|

..... & (o Workspace)

|Ready

Step 2: Select File > New from the PowerBuilder menu bar, and the New diaog box appears.
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Figure 7.2: Adding a new Workspace

M e [#3]

Target: iMat &pplicable)

Warkspace |Tar-;|et | Libiraty | PE Object | DataWindow | Database I Praoject | Taal |

=

[ K, H Cancel ]

Step 3: Select the Workspace icon in the Wor kspace tab and click OK. The New
Workspace dialog box displays. Navigate to the %Appeon%\Power Server\Tool kit
\appeondemo\Tutorial folder, for example, C:\Users\Public\Documents\Appeon\Power Server
\Toolkit\AppeonDemo\Tutorial.

Type appeontutor in the File name text box and click Save.

Figure 7.3: Naming the new Workspace

@ Mew Workspace [#5]
Save i Tutorial + & : il
Marne Date rnodif..  Type Size

Mo iterns rmatch your search,

File name: Save

Cave as bpe: ['W'l:urkspace Files [, pbw] '] [ Cancel ]

The appeontutor workspace has been added and appears as the top item in the PowerBuilder
system tree.
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Figure 7.4: Newly created Workspace

File Run Tools Window Help

mheocdbBe os/ b aRmed 8 o b= s %X % W

NS S F@EENENXY HFE S
%]

=1 appeontutor (C:\Users\Public\Documents\Appeo

Em] m

|Ready

7.2.2 Loading the tutorial PBL file

A PowerBuilder Library (*.pbl file) is acollection of compiled object definitions and source
objects (including scripts) stored in the same location. The PowerBuilder painters and
wizards store various objectsin libraries, such as Applications, Windows, DatawWindows,
Menus, Functions, Structures, and User Objects.

Now load the PBL file of the Appeon tutorial application into the newly created Workspace:
Step 1: Select File > New from PowerBuilder menu bar, and the New dialog box appears.
Click the Target tab if it isnot already selected.
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Figure 7.5: Target tab

i )

I ey @

Target: Mok spplicable)

| W' orkspace | Target |Li|:|rar§.f | PE Object | Dratatindow | Database I Project | Tool

|
& ® B

Application Template Existing Application EfServer Application Server

Application Component Component

MET ‘Web Farms MET Windows  MET Wehb Service  JMET Assembly
Application Forms Application

)

[ Ok J [ Cancel ]

Step 2: Select the Existing Application icon and click OK. Now the Choose Library and
Application dialog box is displayed.

Select the appeontutor application under the appeontutor.pbl, and click Next.

Figure 7.6: Choose Library and Application
[ Choose Library and Application @

Select a library and application object below. If you already have a
target for this application, then just open the target file instead.

-

---Cl AppeonACFDemo o~
-7 AppeonCodeExamples
Databasze
MaobileQrder
SalesapplicationDemo
SAPTechEd2012

-3 Tutorial

=-Bh appeontutor.phbl
: = @-
&7 youhoops

-3 AWS

----- 1 Shared Virtual Machines

F-C3 SQL Anywhere 11 &7
Mame: c:\Usersi\Public\Documents\Appeon'Developer 2013 appeonde

m

< Back [ Mext = ][ Cancel
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Step 3: Click Next inthe Set Library Search Path dialog box.

Figure7.7: Set Library Search Path
rSet Library Search Path @

Set the library search path for the application.

c:\Users\Public\Documents Appeon'\Developer 20 13 appeondemo. » E]

4 1] [ 3

[ < Back ][ Mext > ][ Cancel

Step 4: Click Finish in the Specify Target File dialog box.

Figure 7.8: Specify Target File
[ Specify Target File @

PowerBuilder applications are now stored in files called Targets.
Please spedfy the name of this file below.

Target:

o Uszers\Public\Documents | Appeon\Developer 20 13 appeondemo’ E]

[ < Back ][ Finish J[ Cancel ]

Step 5: The Appeon tutorial PowerBuilder application has now been added to the
appeontutor Workspace and is displayed in the system tree.
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Figure 7.9: Newly added " appeontutor” Workspace

File Run Tools Window Help
rhecEHEevs/EaRnede¥ s sw b Bt k(B
BS SR HEZ0ENXWFER S

|
=== appeontutor (C:\Users\Public\Documents\Appeo
E| appeontutor (c:\Users'Public\Docums
=5 appecntutor.pbl {c:\Users\Public\Docume
m appeontutor
@ d_custom
m_appeoniutor
- w_about
Ifl w_main
---I'_=| w_rand
- w_sheet
L F—— r

|Ready

7.2.3 Configuring ODBC data source

An ODBC data source stores the parameters used to connect to the indicated data provider
through the Open Database Connectivity interface. By setting up the ODBC data source
that identifies the SAP SQL Anywhere database file for the Appeon tutorial PowerBuilder
application, the tutorial application is able to establish a connection with the SAP SQL
Anywhere database through a reference to the ODBC data source name.

To set up the ODBC data source for the tutorial application:

Step 1: Select Tools > Database Pr ofile from the PowerBuilder menu bar, and the Database
Profiles dialog box displays.
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Figure 7.10: Database Profiles

Database Profiles

% Installed Database Interfaces
P-4 ADO Microsoft ADO  MET
74 ASE Sybase ASE 15.x
E2 DIR Direct Connect
H-E4 110 Informix v10.x

-2 IN9 Informix w9.x

7-E4 DB IDBC

74 010 Oracle 10g

74 090 Oracle i

74 ODB CDBC

3 OLE Microsoft OLE DB
---Ej ORA Cracle

: -4 YC Sybase ASE
el 51 Svbase ASE for EAServer

5

Connect

Close

Mew, ..
Edit...

Delete

Step 2: Choose ODB ODBC > Utilities, and then double click ODBC Administrator.

Figure 7.11: Database Profiles

Database Profiles

---Ej INS InfFormix »9.x
-4 1DB JDBC
-4 010 Oracle 10g
-4 090 Oracle 9i
=4 ODB ODBC
=7 Ukilities
%% Create A5A Database
%% Create ODEC Data Source
%% Delste ASA Database
----- ﬁ MabiLink. Synchronization Server
----- W ODEC Administratar
&% uhase Central 5.0
[+-E4 OLE Microsoft OLE DB
&4 ORA Oracle
[H-E3 SNC S0L Mative Client
[
[

+-fE4 3YC Sybase ASE
+-f4 31 Sybase ASE for EAServer

m

1

[l

Conneck

Close

Mew,.,

Edit...

Delete

Step 3: Select the System DSN tab in the ODBC Data Sour ce Administrator dialog box

and click Add.
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Figure 7.12: ODBC Data Sour ce Administrator

P "

2 ODBC Data Saurce Administratar [~ 7| [
Usger DSk | System DSM | File DSM | Diivers I Tracing I Connection Pooling | About |

System Data Sources;

Mame Diriveer Add

=gy SOL Angahere 10
appeonzamples SOL Anywhere 10
tranzlat11h S0L Arpwhere 11 LConfigure...

Bemove

it

An ODBC Spstem data source stores information about how o connect to
EI; the indicated data provider. A Svstern data source iz vizible to all uzers
= on this machine, including HT services.

) ot [ 5w

Step 4: Select the SQL Anywher e 10 driver to connect to the appeontutor.db database file.
Select SQL Anywhere 10 and click Finish in the Create New Data Sour ce dialog box.

Figure 7.13: Create a Data Sour ce

Create Mew Data Source 5]

Select a driver far which pou want to zet up a data source.

\ M ame W
B Microsoft Test Driver [*.t=t; * cev] G
_»E_ Microzaft Text-Treiber [7 ket * cav) G
Microsoft Wisual FosPro Driver 1
Microgoft Wigual FoxPro-Treiber 1
SOL Anywhere 10 1

SOL Sermver G =

ltralite 10 1

4 10 b
¢ Back [ Finizh ] [ Cancel ]

Step 5: The ODBC Configuration for SQL Anywhere dialog box is displayed. Type the
necessary settings into the different tabs as specified in the following table, and |eave other
fields at their default settings.
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Table 7.1: Data sour ce settings

In thistab... In thisfield... You should...
ODBC Data source Type appeontutor
name
Login User ID Type dba (case sensitive)
Password Type sl (case sensitive)
Database Server name Type appeontutor

Database name | Type appeontutor

Database file Click Browse to select the AppeonSample.db
file. For example, C:\Users\Public\Documents
\A ppeon\Devel oper2017\appeondemo\Database

\A ppeonSample.db.
Figure 7.14: ODBC tab
ODEC Configuration for SOL Anyahere 10 -7 |z
ODBC | Login | Database | Metwork | Advanced
Data source narme: appeontutal
Description;
lzalation level:
Microsoft applications [K.evs in SOLStatistics)
Delphi applications
Suppress fetch warnings
Prevent driver not capable enars
Delay AutoCommit until statement cloze
Describe Curzar Behawior
Mewver @ |f required Always
Translatar <Mg Translators
| Select Tranzlatar... |
| Test Connection |
Ok l | Cancel | | Help |
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Figure 7.15: Login tab

| EIDBCl Login | [atabaze | MHetworlk | Advanced|

ODEC Configuration for SOL Anyahere 10 -7 | ==

71 Use ntegrated login
@ Supply uzer 1D and password

User ID: dba

Pazsword: | o -

[T Encivpt password

[ ] 8 H Cancel H Help

Figure 7.16: Database tab

ODBC | Login | Database | Network | Advanced

ODBC Configuration for SQL Anywhere 10 [~ B[S

Server name: appeontutor

Start line:

Databass name:  appeortutor

Database file: peondemo Database" Appeon Sample.db

Browse...

Encryption key:

Start database automatically
[¥]5top database after last disconnect:

[ QK ][ Cancel H Help

Step 6: Go back to the ODBC tab and click Test Connection. Ensure the connection test is

successful before continuing.
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Step 7: Click OK to close the ODBC Configuration for SQL Anywhere dialog box.
The appeontutor is added as a system data source under the System DSN tab.

Step 8: Click OK to close the dialog box and click Close to exit the Database Profiles dialog
box.

Figure 7.17: ODBC Data Source Administrator

P o

3 ODBC Data Source Administratar [~ 5| 3]

Uszer DSH | Syztern DSM | File DSM | Diivers I Tracing I Connection Pooling | About |

Uszer Data Souwrces:

M ame Drriver Add. .
appeontutor SEL Aryhere 10 e |
Bemove
Carahers 10 Demo SEL Arpwhere 10 ;J
SOL Anywhere 10 CustDE - SOL Anywhers 10 Configure. ..
SOL Anywhere 10 Demo SOL Anywhers 10

An ODBC Uszer data source stares information about haw o connect ta
DE the indicated data provider. & User data source iz only visible to you,
©and can only be uzed on the curent machine.

I k. I I Cancel Apply Help

7.2.4 Running the tutorial application

The database connection parameters (PowerBuilder Transaction properties) have been
preset in the tutorial PowerBuilder application that will connect to the data source named
appeontutor. Y ou can run the tutorial application in PowerBuilder now.

To run the Appeon tutorial PowerBuilder application:

Step 1: In the PowerBuilder IDE, choose Run > Run appeontutor from the PowerBuilder
menu bar, or click the Run icon in PowerBarl. The Appeon tutorial PowerBuilder
application starts.
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Figure 7.18: Appeon Tutorial Application

n
File  Help

|e & g

Step 2: In the Appeon Tutorial Application, select File > Drag and Drop to open the Drag
and Drop window.

The Appeon tutorial PowerBuilder application has an MDI window, two sheet windows, and
an About window. In the Drag and Drop window, click the Retrieve button to display data.
Click arow in the Datawindow and hold down the right mouse button to drag and drop the
full namein the row into theright ListBox. Click the Clear button to reset the ListBox.
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Figure 7.19: Drag and Drop

File  Help

Ew@n*

Click the Retrieve button to display data.
Click a row in the DataVWindow, and hold down the right mouse button to drag and
drap the full name in the row inta the ListBox

Customer First Name Last Name Phone Number .
T Michael Deviin (2001) 555-8965 -

102 Beth Reizer [212) BE5-8725

103 Erin Mieder [215) 5556513

104 keghan M azon [E15] BRE-B4E3

105 Laura M Carthy [317] BRE-B427
106 Paul Phillips [203) B55-3464 -~

4| 1 | »

Step 3: Select File > Randomize to open the Randomize a number window.

Thiswindow uses the PowerBuilder Randomize and Rand functions to randomly generate an
integer between 1 and 10, and display it in awindow.
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Figure 7.20: Randomize a number

File Help
|& # e
O Drag and Drop EI@

Click the Retrieve button to display data.
Click a row in the Data¥Window, and hold down the right mouse button to drag and
drop the full narne in the row into the ListBox.

Customer First Hame Last Name Phone Number .

.—GD 101 Michasl
102 Beth
103 Erin
104 keghan
105 Laura
108 Paul
LS

Step 4: Close the tutorial application, and return to the PowerBuilder IDE.

7.3 Configuring PowerServer Toolkit

PowerServer Toolkit, acomponent of Appeon PowerServer, extends the capabilities of
PowerBuilder, alowing anew or existing PowerBuilder application to be converted into a
bona fide Web Application, using only PowerBuilder skills.

PowerServer Toolkit provides a set of tools that enable the entire PowerBuilder-to-Web
process to take place within the PowerBuilder IDE. These tools are accessed viaatoolbar in
the PowerBuilder IDE. The PowerServer Toolkit automatically loads each time PowerBuilder
is opened.

Figure 7.21: Power Server Toolkit
DS O @ ENENXW

B @

The Appeon tutorial PowerBuilder application should run through the following
configuration tasks before PowerServer Toolkit can automate the task of Web conversion and
deployment of the tutorial application.

» Configuring basic settings
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Selecting PBL file(s)

Configuring deployment settings

Selecting DB Type(s)

Declaring transaction object(s)

All these configuration tasks can be completed within the PowerServer Toolkit Configuration

Wizard. To access thiswizard, click the Config Wizard button () on the PowerServer
Toolkit.

Read the requirements on the Welcome screen and click Next to proceed.

Figure 7.22: Welcome page

Appecn Developer Configuration Wizard @

Yelcome to the Appeon Developer Configuration
Welcome Wizard|

The Appeon Developer Configuration Wizard will guide
wou through all the steps required for deploying an

B Configure basic settings application to the Web or to the Mobile. Please verify
B Salact PRI D the following before configuration.

1. The databaze in uze by the application iz rwnning and connected

B Configure deployment settings sussesdll

W Select DB types 2. The application haz been compiled with the *Full Build” cormmand in a

supparted PowerBuilder version.

B Declare transaction object(s)

3. The application runs normally in PowerB uilder.

B Select image files 4 Al PELs have been optimized in PowerBuilder uzing the ""Optimize command.
B Select NI files

5. Application Server is started.
B Deploy Bxternal Files

B Summary

< Back [ Mest = ][ Cancel Finigh

7.3.1 Configuring basic settings

The basic settings refers to the settings of an application that are essential for deployment,
including the application profile name, Web folder, and project type.
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Figure 7.23: Configure basic settings window

Appecn Developer Configuration Wizard @

Please configure the following options:
Welcome

Application Prafile Mame: appeantutol

Configure basic settings ‘wieb Folder sppeontuton

B Select PBL files .

Project Type: [W’el:u e
B Configure deployment settings

Device Type: Bath
N Select DB types

i ; bk

B Declare transaction object(s) Plasils A i SpEaTET

Mabile App lcon: Browse. ..
B Select image files Mabile App Description: -

B Select INI files

B Deploy Bxternal Files

B Summary

[ < Back ][ Mest = ][ Cancel Finigh

Step 1: Specify the settings as follows:
* Inthe Application Profile Name field, input appeontutor.

* Inthe Web Folder field, input appeontutor (Thisfield is automatically filled with what
you enter in the Application Profile Name field, so you may just need to check it.).

» Select Web from the Project Type dropdown list box.

Step 2: Click Next to proceed.

7.3.2 Selecting PBL file(s)

Specify the version and the location of source code of the PowerBuilder application.
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Figure 7.24: Select PBLs

Appecn Developer Configuration Wizard @

Select the PBL files used in your application:
Welcome

Configure basic settings PBT: C:AUzers\Public\Documentz\appeoniDeveloper201 34 B

Select PBL files Kesp PET Updated

B Configure deployment settings

PELVersion. | PowerBuilder 115 -

N Select DB types

FEL File List:

c:huzershpublichdocument s\ appeonhdeveloper20l Fappeondemot zalesapplic »
c:huzershpublichdocument s\ appeonhdeveloper20l Fappeondemot salesapplic
o huzershpublichdocument s appeonhdeveloper20l Fappeondemotzalezapplic

B Declare transaction object(s)

B Select image files

B Select INI files

B Deploy Bxternal Files 1 1 | b

Add... Remove

B Summary

[ < Back ][ Mest = ][ Cancel ] Finigh

Step 1: Verify that appeontutor.pbt is currently selected in the PBT field. Or click the browse
(...) button to select the appeontutor .pbt file.

When the appeontutor .pbt file is selected, the appeontutor PBL file is automatically added to
the PBL FileList.

Step 2: Check the Keep PBT Updated checkbox.
Step 3: Choose a PowerBuilder version from the PBL Version dropdown list box.
Step 4: Click Next to proceed.

7.3.3 Configuring deployment settings

The deployment settings associate the PowerServer(s) and Web server(s) as agroup used for
application deployment. In this tutorial, the deployment profile will associate Power Server
Tutor and Web Server Tutor.

In this section, you will learn:

Starting PowerServer and Web server

Adding a PowerServer profile

Adding a Web server profile

Selecting a deployment profile
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7.3.3.1 Starting PowerServer and Web server

When adding the PowerServer profile and Web server profile, you need to verify the
connection to the PowerServer and the Web server; therefore, you should start them before
configuration. If you want to start PowerServer installed to WebL ogic, WebSphere, JBoss, or
JEUS, refer to Installation Guide for .NET for detailed instructions. In thistutorial, 1S will
be used as both the PowerServer and the Web server. Therefore, you only need to start I1S.
Refer to the following steps for how to start the |1S/PowerServer.

Select Windows Start > Programs > Appeon Power Server 2017 > Power Server for .NET
> |ISManager.

Make sure that the Web Site where PowerServer isinstalled is started, as shown in the
following figure. If not, please select the name listed on the Web Site page and click Start on
the Actions paneto start it. If it is started, the Start menu will be grayed out. The following
figure indicates that PowerServer and Web server are ready for use.

Figure 7.25: | | S/Power Ser ver

i34 iis - [Internet Information Services (I5) Manager] (=ERE==
Eile  Help
& [[8) TESTORTISTA » Wb Sites » |&@ @ -
Connections - . Actions
UJ' Web Sites P : A
i =1 @ Addveb Site..,
RE q .
< TH TESTOXISTA TS| i, - (60 - G Show Al | Group by: . SetWeh i el
J Application Poo z - M Web Sit
&, FTP Sites Marme 1D Status Binding anane e
4[] Web Sites & Detauitivebsite 3 Started e v Rt
@ Defaultieby & test 3 Started 81 Chitp)
D test B Stop
K Remove
B Explore
Browse Web Site
[®1 Browse
Edit Site -
Bindings...
D Basic Settings..
Advanced Settings...
Renarne
Wiew Applications
Wiew Wirtual Directories
Configure
Failed Request Tracing..
. = » Lirnits...
@ Help
Ready HI_EI

7.3.3.2 Adding a PowerServer profile

Each PowerServer profile contains settings of a PowerServer/application server used by the
Appeon deployment.
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Figure 7.26: Power Server profile

Appecn Developer Configuration Wizard

Welcorne

Configure basic settings
Select PBL files

Configure deployment settings

N Select DB types

B Declare transaction object(s)
B Select image files
B Select NI files

B Deploy Bxternal Files

B Summary

Please select the Appeon Server(s) and Y¥eb server(s)

that your application will be deployed to:

X

Deployment Profile Mame: Local Deploymet

Appeon Servers

Selected  Mame
Local Appeon Server

Edit...
d

Delete

Wwieb Servers

Selected Mame
Local web Server

Edit...

d

DEBIBRE L

Delete

< Back “ Mest = ][ Cancel

Finigh

To add the PowerServer profile for the deployment of the tutorial application:

Step 1: Click the Add button in the Power Server group box.

The PowerServer Profile Configuration dialog box appears.
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Figure 7.27: Power Server Profile Configuration

Appeon Server Profile Configuration @
Profile Settings Appeon Server Settings
Erofile Marme: Appean Server Tutor Server Type: JZEE @ MET
Server: lozalbost

Server Part [http]: 80

AEM Settings Deployment Security Settings
YWhen using HTTPS, please make sure vou have Deployment Security:  Dizabled Get State
configured a listener for the SSL connection to thiz —
Appeon Server.

Ilzerame and Paszword should be configured in AE .
AEM  http/? localhost: B0AAEM

Connection Method: @ HITP HTTPS

Test Settings

After entering the Appeon Server settings, we recommend you test the settings by clicking the button belov.

T est Appeoh Server Settings...

| Ok || Cancel |

The following table lists instructions for how to specify the properties for a PowerServer
profile.

Table 7.2: Instructionsfor creating a Power Server profile
Profile Name Input "AppeonServerTutor” as the name of the PowerServer profile.
Server Input "localhost".

To deploy to aremote PowerServer, enter the IP address or machine
name of the remote server.
Server Type Make sure that .NET is selected.

If PowerServer isinstalled to WebL ogic, WebSphere, JBoss, or
JEUS, then select "J2EE".

Server Port (http) Input "80".

If PowerServer isinstalled to WebL ogic, input "7001"; if installed
to WebSphere, input "9080"; if installed to JEUS, input "8088"; if
installed to JBoss, input "8080".

To deploy to aremote PowerServer, enter the HTTP port of the
remote server.

AEM URL The URL for AEM will be automatically generated after Server and
Server Port are specified.

Connection method | Leave it as default.
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Property Instructions

Deployment Security | Leaveit as default.

Username Leave it as defaullt.

Password Leaveit as defaullt.

For detailed instructions about these settings, refer to Section 4.2.3.2, “ PowerServer profile
settings’ in Power Server Toolkit User Guide.

Step 2: Click Test Power Server Settings.

PowerServer Toolkit will try to connect to PowerServer with the parameters you specified.
Make sure the test is successful before you continue.

Figure 7.28: Test connection

Infarmation @I

| Testing Sppeon Server Appeon Server Tutor succeeded!

Ok

Step 3: Click OK.

Power Server Tutor is added to the PowerServerslist.

Figure 7.29: Power Server Tutor isadded

Appeon Developer Cenfiguration Wizard ==

Please select the Appeon Server(s) and Web server(s)

Welcome that your application will be deployed to:

Configure basic settings Deployment Profile Marne: Local Deplayment v]
Select PBL files Appeon Servers
Configure deployment settings Selected  Mame
B Select DB types Local Appeon Server gEE
B Ded] N " bject(s) [ Appeon Server Tutor =
ecldre ransacuon oojecils ‘
(oo
Wwieb Servers
B Select image files -
Selected Mame Edit...

W Select INI files Localweb Server i

B Deploy External Files

Delete

N Summary

< Back ][ Hext = ][ Cancel Finizh
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7.3.3.3 Adding a Web server profile
Each Web server profile contains settings of a Web server used by the Appeon deployment.

Since 1S will be used for the deployment of the Appeon tutorial PowerBuilder application,
you need not to start it because 11 S/PowerServer is aready running.

To add the Web server profile for the deployment of the tutorial application:
Step 1: Click the Add button in the Web Server s group box.
The Web Server Profile Configuration dialog box appears.

Figure 7.30: Web Server Profile Configuration window

[ ®E Web Server Profile Configuraticn i"j—r
Profile Settings YWeb Server Seftings
Prafile M anme: wieb Server Tutor Server Type: Microzaft 115 - |
File Transfer Tvpe: | Local Server - HTTP Server: localhost
HITF Fuort: a0
Local Server Settings FTP File Tranzsfer Settings

“web Boot Path: C:hinetpubhir oot

[E.g.. for EAS erver Web Server, this should be the

full path to ZlAGUAR ENRtml )
Browse...

Test Settings

After entering the \Web Server settingz, we recammend that you test the settingz by chcking the button below.

Test Web Server Settings...

| ] | | Cancel

The following table lists instructions for how to specify the properties for a Web server
profile.

Table 7.3: Instructionsfor creating a Web Server profile
Profile Name Input "Web Server Tutor" as the name of the Web Server profile.
File Transfer Type | Select Local Server.

To deploy to aremote Web Server, select Remote Server, and then
specify the FTP Port, FTP Username and FTP Password of the remote
server.

HTTP Server Input "localhost".
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Property Instructions
To deploy to aremote Web Server, enter the | P address or machine
name of the remote server.

Server Type Select Microsoft 11S.
If using WebLogic HTTP server, select WebL ogic; if using
WebSphere HTTP server, select WebSphere; if using JEUSHTTP
server, select JEUS; if using JBossHTTP server, select JBoss.

HTTP Port Input "80".
If PowerServer isinstalled to WebL ogic, then input "7001"; if installed
to WebSphere, then input "9080"; if installed to JEUS, then input
"8088"; if installed to JBoss, then input "8080".
To deploy to aremote Web Server, enter the HTTP port of the remote
server.

Web Root Path Click Browse to navigate to the path to the I1S Web site home

directory (for example: C:\Inetpub\wwwroot).

For detailed instructions about these settings, refer to Section 4.2.3.3, “Web Server profile
settings’ in Power Server Toolkit User Guide.

Step 2: Click Test Web Server Settings.

PowerServer Toolkit will try to connect to the Web server with the IP (localhost) and port
(80). Make sure the test is successful before you continue.

Step 3: Click OK.

Web Server Tutor is added to the Web Serverslist.
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Figure 7.31: Web Server Tutor isadded

Appecn Developer Configuration Wizard

Welcorne
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Select PBL files

Configure deployment settings

Please select the Appeon Server(s) and Y¥eb server(s)
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Delete
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Selected  Mame Edit...
LS slEEa g Local Web Server

WWeb Server Tutor

d

DEBIBRE L

Delete

B Summary

< Back ][ Mest = ]

[ Cancel Finigh

7.3.3.4 Selecting a deployment profile

A deployment profile associates PowerServer(s) and Web server(s) as agroup used for Web

deployment.

Step 1: In the Deployment Profile Name list box, select Local Deployment.

If no deployment profile is available, create one by following instructionsin the
Section 4.2.4.2, “Deployment profile settings’ in Power Server Toolkit User Guide.

Step 2: Select Power Server Tutor in the PowerServer list and select Web Server Tutor in the

Web Serverslist.
Step 3: Click Next to proceed.
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Figure 7.32: Deployment Profile

Appecn Developer Configuration Wizard
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7.3.4 Selecting DB Type(s)

Select the database type used by the application. In thistutorial, the database type is SAP SA |
UltraLite. Select the Used column of SAP SA | UltraLite.
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Figure7.33: DB Type

Appecn Developer Configuration Wizard

Select the database type(s) used by your application:
Welcome

L ) . Mate: 'ou must zpecify the databaze type(z] that your application uzes, but it iz not
Configure basic settings necessam to specifiu the exact database(s) used in this particular application. This
_ . zetting enables Appeon Developer to apply the correct type of database driver for
Select FBL files generating the correct databasze syntax for PowerBuilder SGL statements in the
application.

Configure deployment settings

Select DE types i

Ilzed Supported D atabase Types Configured =

B Declare transaction object(s) B Sybase ASE Mo
Sybase ASA | Ultralite I
]  IBMDE2UDB No =

B Select image files 7 Sybase 10 Mo

B Select INI files ] IBM Infomix Mo
[ Oracle 10g411g Mo I
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| Edt. | [ Tes

B Summary

< Back “ Mest = ][ Cancel Finigh

If SAP SA | UltraLiteis not configured (The Configured column is "No"), you should select
it and click the Edit button to create a profile for it. The Database Type Profile Configuration
window will be displayed.
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Figure 7.34: Database Type Profile Configur ation window

®5 Database Type Profile Configuration @
For each database twpe uzed in your application(z], you must provide an ODBC ar Mative Interface connection to a
databaze af that type in order for Appeon Developer o connect to the data source during deplovment.
Yau need only provide ane connection to each twpe of database uzed in your application.
D atabaze Settings
Databaze Tupe: Sybaze ASA | Ultralite
Databasze Interface: @ DDﬁElnterface Mative Interface
Spntas: | Encloze table and colurn names in Quotes
Outer Jaoin Sypntas: |.-'1'-.NSI - |
ODBC Interface Mative Interface
Data Source:; | AppeonSample - |
User 1D
Pazgwiord:
ODBLC Adminiztratar...
Test Connection [ k. ] | Carnicel

Step 1. Select the Outer Join Syntax that PowerBuilder will format from the drop-down list
for Database in the Database Type Profile Configuration window.

Step 2: Specify the following settings for ODBC interface in the Database Type Profile
Configuration window.

Table 7.4: Database type profile settings

In thisfield Y ou should

ODBC Interface | Choosethe ODBC Interface radio button.
Data Source Choose appeontutor from the dropdown list.

If appeontutor is not available, please choose the Appeon demo database
(appeonsampleforserver or appeonsample2forserver), or any other SAP

SQL Anywhere data source.
User ID Leave thisfield blank.
Password Leavethisfield blank.

Step 3: Click Test to verify that the connection is successful.
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Figure 7.35: Test successful

Inforrmation ==

:] Testing the database succeeded!

Ok

Step 4: Click OK.

7.3.5 Declaring transaction object(s)

When the tutorial PowerBuilder application is deployed to the Web, PowerServer handles
the database connection using data sources rather than transaction objects defined in the
PowerBuilder application. Y ou must associate the transaction objects used by the Appeon
tutorial PowerBuilder application with proper data sources.

Figure 7.36: Transaction object mappings

Appecn Developer Configuration Wizard @

Please specify the transaction object{s) used in the

Welcome application and the corresponding data source(s):

o Tranzachion Object Data Source DB Type
Select FBL fifes
Configure deployment settings
Select DF types

Declare transaction object{s)

B Select image files

B Select INI files

B Deploy External Files

Configure. . Add. Delete

N Summary

[ < Back ][ Mext = ][ Cancel ][ Finigh l

The Appeon tutorial application uses the SQLCA transaction object which connects to the
appeontutor database. To associate the SQLCA transaction object with the proper data
source:

Step 1: Click Add. The Add Transaction Object dialog box is displayed.
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Figure 7.37: Add transaction object mappings

Add Transaction Object @
Transaction Object; sglca
[Databaze Type: Sybaze 454 | Ultralite b
Data Source:

IF pour Appeon Server iz the MET edition, vou can alzo select, edit, add, or delete the data
gource in the below Data Source group box,

Drata Source

Appeon Server -

Selected  Mame DB Host

Edit.. Add... Delete

] 4 ] | Cancel

Step 2: Select SAP SA | UltralLite from the Database Type dropdown listbox.

Step 3: Select Power Server Tutor from the Power Server list. The existing data sourcesin
PowerServer will be displayed.

Note: the data source tool is available for Microsoft .NET Framework, and not available for
WebL ogic, WebSphere, JBoss, or JEUS. Y ou should go to the corresponding application
server administration console to configure the data source for WebL ogic, WebSphere,
JBoss, or JEUS. For detailed instructions, refer to Chapter 4, Database Connection Setup in
Power Server Configuration Guide for J2EE.
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Figure 7.38: Data sour cesin the Power Server

Add Transaction Object @
Tranzaction Object: zglca
[Databaze Type: Sybaze 454 | Ultralite b
Data Source: appeonzample

IF pour Appeon Server iz the MET edition, vou can alzo select, edit, add, or delete the data
gource in the below Data Source group box,

Data Source
Appeoh Server: [.ﬁ.ppean Server Tutar -
Selected  Mame DE Host
“ appechsarnple AppeonSampleForserver
& appeohzample: AppeonS ample2FarSerer
wouhoops YouHoopsForServer
SAPTechEd2012 SAPTechEd201 2ForServer
Edit. | | 4dd. || Delte |
[ ] 4 ] [ Cancel

The following steps show you how to create a data source that links to the appeontutor
ODBC data source using the ODBC driver.

Step 4: Click Add to create a data source. The Add dialog box is displayed.
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Figure 7.39: Add a data source

Add Data Source @
Mame: appeantutar
Databaze
Drriver. ODBLC Driver hd
Huost:
Part:
ODEC D ata Source: |.-'1'-.ppe-:un5ample -
Uzer Mame: dba
Pazaword: sea
Character Set: ASCI
Session Mode: DEFALILT
M aximum Connection Pool Size: 100
Minirmum Connection Pool Size: 10
Connection Timeout [seconds]: 120
Command Timeout [zeconds]: a0
Connection Lifetime [seconds): 0
Other Options:
Dynamic Database Connection | Pooling
| Test | [ Ok ] | Cancel |

The following table provides instructions for how to specify the data source settings.

Table 7.5: Instructionsto specify data sour ce settings

Settings Instructions

Name Input "appeontutor” as the name of the data source.
Driver Select "ODBC Driver" asthe driver type for the data source .
ODBC Data Source | Select "appeontutor” as the data source name.

Thiswill connect to the appeontutor ODBC data source that was
created in Section 7.2.3, “Configuring ODBC data source”.

If the database type is SAP SQL Anywhere and the database file
residesin an NTFSfolder, please grant the "NETWORK SERVICE"
or "Everyone" user with full controls over that folder.
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Settings Instructions

User Name Type "dba".

Password Type"sql”.

Step 5: Click Test to verify the connection to the appeontutor data source.
Step 6: Click OK to close the Add dialog box.

The appeontutor data source has been added.

Step 7: Select the Selected button of the appeontutor data source.

Figure 7.40: appeontutor isadded

Add Transaction Object @
Tranzaction Object: zqlca
Databaze Type: Sybaze 454 | Ultralite -
Data Source: appeantutar

[f wour Appean Server iz the MET edition, pou can alzo select, edit, add, ar delete the data
gource in the below Data Source group box,

Drata Source
Appeohn Server: Appeon Server Tutor b
Selected  Mame DB Haost

appeohzample AppeonS ampleForServer
appeonzamples AppeonS ample2ForSerer
youhoops Y'ouHoopzFarServer
SAPTechEd2012 SAPTechEd2012FarServer
appeantutar AppeonSample

| Edt. || add. || Deete |

[ OF. ] l Cancel

Step 8: Click OK to close the Add Transaction Object dialog box.
The"sglca" transaction object is added.
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Figure 7.41: sglcaisadded

Appecn Developer Configuration Wizard

) Please specify the transaction object(s) used in the
Welcome application and the corresponding data source(s):

Configure basic settings

Tranzaction Object Data Source DB Type
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appecntutor Sybaze ...
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B Summary

< Back ][ Mest = ][ Cancel ][ Finigh

Step 9: Click Next through the rest of settings, until you get to the Summary page.
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Figure 7.42: Summary

Appecn Developer Configuration Wizard @

The following is the summary of settings for your
application deployment. To change any settings. click
Back.

Welcorme

Configure basic settings Application Prafile Mame: -
appecntutar b
Select PBL files Application URL:
appeantutar L
Configure deployment settings Praject Type: 3
Wwieh
Select DE types M obile &pp loom: o
[Mone]
Peclare transaction object{s) | Mobile App Descriphion:
| [Mone]
Device Type:
Both
Select image files Mobile App M ame:
4 appeontutar
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1 | 1 3

Deploy External Files

Deplay the application now

Summary

T

Step 10: Click Finish on the Summary page to close the wizard.
The Appeon tutorial application is successfully configured.

The Appeon Deployment Wizard will be launched, if you keep the "Deploy the application
now" option on the Summary page as selected. Refer to Section 7.5, “ Deploying the Tutorial
PowerBuilder Application” for how to use it.

7.4 Analyzing Unsupported Features

This chapter shows you how to use the UFA tool to analyze the Appeon tutorial
PowerBuilder application for unsupported features and optimize and full build the tutorial
application.

In this chapter, you will learn how to:

* Perform unsupported feature analysis on the tutorial application

* Optimize and full build the tutorial application

7.4.1 Unsupported features analysis

Appeon provides an unsupported feature analysis (UFA) tool to handle the Appeon
unsupported source code in a PowerBuilder application.

To perform Unsupported Features Analysis to the tutorial application, perform the following
steps:
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Step 1: In the PowerBuilder IDE, click the Analyze button (" or @) on the PowerServer
Toolkit. The Unsupported Feature Analysis Report window (UFA Report window) appears.

Figure 7.43: UFA Report window

@ Unsupported Feature Analysis Report - appeontutor E'@
File Edit View Tools Help
DEHE a0 (ARSI X

| -

------ ' Mo unsupparted features in the application [appeontul

Step 2: Select the File > New Report menu in the UFA Report window. The New UFA
Report dialog box will appear.
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Figure 7.44: New UFA Report dialog box

Mew UFA Report =

-

Application Prafile; AppeohtLkar - |
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----- E' appeantutor
+ Eﬂ o huzershpublichdocument s\ appeontdeveloper20l 3 appeondem:

o | Dizplay Full Path

Refresh [ ak. ] | LCancel

Step 3: Click the OK button to analyze the entire application.

The Unsupported Features Analysis Status dialog box is displayed. This shows the progress
of the Unsupported Features Analysis.

Figure 7.45; Unsupported Features Analysis Process dialog

Unsupported Features Analysis Process @

Time Fun Information

135458 Analyzing unsupported features for D atawindow d_custom,
1354:58  Analyzing unsupparted features for Application appeontutar,
1354:58  Analyzing unsupparted features for Window w_about,
1354:58  Analyzing unsupparted features for Window w_main.
1354:58  Analyzing unsupparted features for Window w_rand.
1354:58  Analvzing unsupparted features for Window w_sheet,
135458 Analyzing unsupported features for Menu m_appeontutor.

m

L L L

135459 Finished analyzing unsupported features.

T 3

1002
Wiew Log.. . Cloze

e

Migration Guidelines for PowerServer Web Page 82



Migration Tutorial Appeon® PowerServer® 2017

After the feature analysis is completed, click the Close button and the UFA Report isloaded
into the UFA Report Window. Y ou can view the analysis result in the left treeview and
modify the unsupported features by following the instructions in the Chapter 6, Workarounds
for Unsupported Featuresin Workarounds & APl Guide, which is aso available at http://
www.appeon.com/support/documents/appeon_online_help/workarounds and_api_guide/.
The Guide provides examples of some common unsupported features and ways to work
around them.

In this tutorial, the application contains no unsupported features.

Figure 7.46: UFA Report window

= Unsupported Feature Analysis Report - appecntuter EI@
File Edit View Tools Help
D M4 B2 H

All unzupported items in the application [appeontutar] [0 unzupported features)

7.4.2 Optimizing and full build

Before any PowerBuilder application is converted by Appeon, ensure the PBLs have been
optimized. Y ou must also "full build" the PowerBuilder application successfully before
Appeon will be able to convert it.

To optimize and full build the tutorial application:
Step 1: Right click on appeontutor.pbl in the PowerBuilder system tree. Click Optimize.
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Figure 7.47: Optimize
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Step 2: Right click on the appeontutor Target in the system tree and select Full Build from
the context menu.
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Figure 7.48: Full Build
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Step 3: The full build process begins. Some information is displayed in the Output window.
Make sure that when the full build is complete, no error messages occur in the Output
window.

Figure 7.49: Finished Full Build of target appeontutor

Il Default

Rebuilding type { pass 2 ) C:'\Users'\Public\Documents'Appeon'Developer 20 13\appeondema {Tutorial\appeontutor, pbl{w_about)... -
Rebuilding type { pass 2 ) C:\Users\Public\DocumentsAppeon'Developer 20 13\appeondema {Tutorial\appeontutor, pbl{w_main)...

Rebuilding type { pass 2 ) C:\Wsers'Public\Documents\Appean'Developer 20 13 \appeondema Tutorial \appeontutar, pbl{w_rand)...

Rebuilding type ( pass 2 ) C:'\Users\Public\DocumentsAppeon'Developer 20 13\appeondema {Tutorial\appeontutor, pbl{w_sheet). ..

Regenerating C:YJsers\Public\Documents\Appeon\Developer 20 13\appeondemo {Tutorial\appeontutor. pbl{d_custom)...

Regenerating C:\Jsers\Public\Documents\Appeon'Developer 20 13\appeondemo {Tutorial\appeontutor. pbl(appeontutor)...

Regenerating C:'Jsers\Public\Documents\AppeonDeveloper 20 13 appeondemo {Tutorial\appeontutor. pbl{(m_appeontutor)...

Regenerating C:YJsers\Public\Documents\AppeonDeveloper 20 13\appeondemo {Tutorial\appeontutor. pbl{w_about)... EI

Regenerating C:'Jsers\Public\Documents\Appean\Developer 2013 \appeandemo {Tutorial\appeontutor. pbl {w_main). ..

Regenerating C:'Jsers\Public\Documents\AppeonDeveloper 20 13\appeondemo {Tutorial\appeontutor. pbl{w_rand). ..

Regenerating C:'Jsers\Public\Documents\AppeonDeveloper 2013 \appeondemo {Tutorial\appeontutor pbl{w_sheet). .. -
< | m | 3
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7.5 Deploying the Tutorial PowerBuilder Application

In the previous lessons, the Appeon tutorial PowerBuilder application has undergone careful
analysis for unsupported features. Now you will launch the Appeon Deployment Wizard to

convert the tutorial application onto the Web automatically.
To deploy the tutorial application onto the Web automatically:

Step 1: Make sure PowerServer is started. For details, refer to Section 7.3.3.1, " Starting

PowerServer and Web server”.

Step 2: Within the PowerBuilder IDE, click the Deploy button (ﬁ) in the PowerServer

Toolkit. The Appeon Deployment Wizard starts.

Figure 7.50: Appeon Deployment Wizard

ﬁ Appeon Deployment Wizard - appeontutor E =] @

The Application Deployment *izard will guide wou through the automated conversion process.
Pleaze enzure that the carect PawerBuilder application and deplowment setting: have been
zelected and press Mest to continue.

PowerBuilder &pplication

Application to be deployed: | Appeantutor A |
Deplayrment prafile: | Local Deployment - |
Deployrment mode; | Full &pplication Deplayrment - |
V| Unattended Deplayment Adwanced...

Reparting Options

| Generate Unsupported Features Analyzsis Beport

[ Mext » ] | Cancel

The start page of the Wizard displays the following information:

Application to be deployed - The current application (appeontutor) is selected by default
from the list of applications that are defined in PowerServer Toolkit application profiles.

Deployment profile - Make sure the deployment profile, Local Deployment, is selected.

Deployment mode - Sinceit isthefirst time the tutorial application will be deployed,
the Full Application Deployment mode will be selected by default. For subsequent
deployments, the Incremental Application Deployment will be selected by default.

Unattended Deployment - Check this option so that the entire deployment processis
automatic.

Step 3: Click Next to start the automatic Web deployment process. The Appeon Deployment
Wizard will perform three tasks:
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1. PowerBuilder application source code export and analysis (Task 1. Application Source
Code Export).

2. Parsing of the PowerBuilder source code (PBL files) into Web application files that are
stored on the local machine (Task 2: Appeon Application File Generation).

3. Transfer of local Web files to the Web Server by using either file copy or FTP, and
uploads DataWindows to the PowerServer (Task 3: Appeon Application Deployment).

When the deployment process is complete, the report dialog box is displayed.
Step 4: Click Finish.
Figure 7.51: Appeon Deployment Wizard

= Appecn Deployment Wizard - appecntutor E [=] @

Deployment Information

Application deployed: appeontutor
Deployment mode: Full &pplication Deplayment
Deployment profile uzed: Local Deployment

Deployment Task Summary

Tazk Status Time

Tazk 1: Application Source Code E=part Completed < 1 Minutes
Tazk 2 Appeon Application File Generation Completed < 1 Minutes
Tazk 3 Appeon Application Deployment Completed < 1 Minutes
Tatal Time Elapzed far Automatic Corversian < 3 Minutes

Log Informatian

Warhings and Errars Summary: Ermors: O ; Warhings: 0 “iew Loa...
Reportz
Features Analyziz report available: Analpziz Report...
Finizh Firizh and D ebug Finizh and Bun...

7.6 Running the Web Application

The Appeon tutorial PowerBuilder application has been converted into a standard Web
application with proper database connection which can now be run.

To launch the Web application after the tutorial application has been converted:
Step 1: Make sure PowerServer is running.
Step 2: Click the Run button (éf’) in the PowerServer Toolkit and select the appeontutor

application in the popup window, or manually open a browser window and type http://
|ocal host/appeontutor/ into the Address bar and press Enter.

The Web application starts.
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Figure 7.52: Application starts

> |a http://lacalhostfappeantutor| 'l‘j X || Live Search P~

File Edit Wiew Favorites Tools Help

3 »
W [9 Appeon Download Center [ v v Page v {J Tools »
Appeon Web Application
~Mode
& RunMow For high speed netwark. The application runs immediately and
files are downloaded only when needed. Recommended far
broadband connection, such as xDSL.
Run After For low speed network. Al files will be downloaded before the
Drownload i -
application runs. Recommended for namowband connection,
such as modem or ISDN
Appeon
S — 4
Daone E . Internet | Protected Mode: Off 0% v

Click OK to run the Web application now.
Figure 7.53: Application starts

- |E http://lacalhostfappeontutor/application.htm| v- Live Search L~

File Edit View Favorites Tools Help

3 »
ﬁ afe [ﬁAppeonTutorlaIAppI\catlon @ - - & - Eage = ﬂTgUIS =
File  Help
| & &
Internet | Protected Mode: Off 0% v
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Step 3: Open the Drag and Drop window.

Figure 7.54: Drag and Drop

'|‘f|x||.l.ime5emd:

File Edit \iew Favorites Tools  Help

W leAppeDnTutoriaIAppI\cation - v = v |ih Page v {0} Tools v >
File Help
| & g

Click the Retrieve button to display data
Click a row in the DataWindow, and hold down the right mouse button to drag and
drop the full name in the row into the ListBox.

Customer First Mame Last Name Phone Number .
Dreviin [201] 555-8966 U

Fieiser [212) 555-8725

103 Erin Migder [215) 555-6512

104 teghan fazon [615] 555-5463

108 Laura tcCarthy [317) 505-8437
106 Paul Phillipz [203) B56-3464 -

< il ] »

Ph Internet | Protected Mode: Off

Step 4: Open the Randomize a number Window.
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Figure 7.55: Randomize a number Window

~ | &) 2~
Eile  Edit “iew Favorites Tools Help
ﬁ by [eAppennTutoria\App\ication m ﬁ *, = @ . Eage = QTEUB -7
File Help
| & &

[ Drag and Drop

Click the Retrieve button to display data.
Click a row in the Data¥Window, and hold down the right mouse button to drag and
drop the full name in the row into the ListBox.

Customer First Mame Last Name Phone Number .
1D

m Michael
102 Beth
103 Eiin
104 teghan
108 Laura
108 Paul

[ F—

Generate a randomized number between 1 and 10

3 i Generate

Ph Internet|Protected Mode: Off 00 -
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